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1 Introduction 
 

1.1 Product Details  

 
Welcome to the SLIM CD, your Secure Link In Merchant Services.  This manual is a 
complete reference guide to the SLIM CD software and contains information needed to 
securely manage and process credit card and check transactions from your IBM-
Compatible personal computer. 
 
The SLIM CD provides merchants with full control of their credit card and check 
processing with a user-friendly interface. In addition, SLIM CD has a built-in fraud 
prevention system. 
 

1.2 Product Capabilities 

 
The SLIM CD interface allows the merchant to administer clerks, process transactions, 
and view reports via the interactive terminal contained on the SLIM CD. The SLIM CD 
uses the Internet to rapidly process transactions and the history can also be viewed from 
the Internet using the SLIM CD software. 
 
 
 

1.3 System Requirements 

 
In order to run the Slim CD software, your computer must meet the following guidelines: 
 

� A Minimum of 200 MHZ  

� IBM-Compatible  

� Utilize Microsoft Windows 98 / NT / 2000 / XP / 2003 

Operating System 

� 32 MB of Available RAM Memory 

� 15 MB of Available Hard Disk Space 

� A CD-Rom Drive 

� An Active Internet Connection Capability such as a 
networked, cable modem, ISDN, or dial-up modem 
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1.4  Hardware Options 

 
The SLIM CD supports Card Swipes, Pin Pads, Signature Pads, Check MICR readers, 
Check Imagers, General Receipt Printers, and High-Speed Receipt Printers.  

 
Note: USB port versions of all printers are strongly recommended. 

 

1.4.1 Card Swipe Device Options 

 

� USB interface Credit Card Reader for Track 1 & 2 data 
Note: MagTek® part number 21040108 is recommended 

� Magtek MINI-MICR in either Keyboard, USB or Serial 
configurations 

� Magtek MICR-IMAGER USB or Serial configurations 

 

1.4.2 Pin Pads 

 

� Ingenico® encrypt-100 

� Verifone® 1000SE Pin Pad 

� Verifone® 2000 Pin Pad and integrated card swipe device 

� IntelliPIN card swipe and debit keypad combination device.  

Note: MagTek® part number 30015135 

 

1.4.3 Signature Pads 

 

� ePadTM Electronic Signature Capture Device by Interlink 
Electronics®, only with an ePad driver. 

Note: Supported by ePad
TM 

, ePad
TM 

POS, or ePad
TM 

Ink  (LCD)
 
models. 

                 

� Topaz signature capture Devices. 

Note: Supported by SigLite
TM
 1x5 Z-T-S460-HSB, SigLite

TM  
LCD 1x5 Z-T-L460-HSB, 

and SignatureGem
TM
 LCD 1x5 Z-T-L462-HSB models. 
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1.4.4 Check MICR readers 

 

� Magtek MINI-MICR in either Keyboard, USB or Serial 

configurations 

� Magtek MINI-MICR with built-in MSR Card reader in either 

Keyboard, USB or Serial configurations 

 

1.4.5 Check Imagers/Scanners 

 

� Magtek Imager, Serial configuration, with or without MSR 
card reader  

 

1.4.6 General Receipt Printers 

 
Note: Use with MS-Windows’ Generic Text print driver. 

� Verifone 250 or 900 

� Ingenico Scribe 612 

� Peripheron Technologies’ ReceiptMaster 2000 

� Citizen® or Epson® dot-matrix receipt printer 

 

1.4.7 High-Speed Receipt Printers 

 

� Epson® TM-88 II or TM-88 III 

� Axiohm® thermal receipt printers 

� Star-Micronics TSP-100 or Greater 

� Any normal printer can be used with its Windows print driver. 

 
Note: Use with the manufacturers supplied print driver. 

Note: USB port versions of all printers are strongly recommended. 

 
 

1.4.8 Bar-Code Readers 

 

� E-Seek 250 Magstripe & 2D Barcode Reader 
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1.5 Most Frequently Used Features 

 
Feature: Menu 

Selection: 
Screen Display: Enables: 

Transaction 
Menu 

VPOS A virtual terminal Credit card transactions to be processed. 

Transaction 
Menu 

Stats A search engine Prior transactions to be viewed, by a 
variety of criteria. 

Database 
Menu 

User Setup A list of Clerk IDs 
and User Names 

ADMIN to set up or change the Clerk’s ID 
used to login into SLIM CD and process 
transactions. 
 

Dial-Up 
Menu 

Dial-Up Menu Connection Status Checks Internet and/or ISP Connection 

 
Note: VPOS- stands for Virtual Point Of Sale 

 

1.6 Most Frequently Used Transaction Types 

 
Transaction 
Types: 

Allows the User to: In Order to Process: 

Auth Authorize a hold on a 
consumer’s credit card’s 
“Open to Buy” amount for 
3-5 days. 

A corresponding Force transaction must be 
performed to complete the sale. 

Force Conduct the Auth 
Transaction to hold funds. 

The ticket # from the original Auth Transaction must 
be entered. 

Credit Return funds to the 
consumer’s credit card. 

The ticket # from the Charge or Force Transaction 
must be entered. 

Sale Place a charge on the 
consumer’s credit card for 
a specific amount 

This amount will be deposited in this merchant’s bank 
account. 
 

Void Void a Sale, Force, or 
Credit Transaction 
recently performed. 

The GateID or GatewayID from the original 
transaction must be entered. Note: If voiding a sale or 
force is unsuccessful, use the Credit Transaction to 
return funds to the consumer’s credit card. 
 

CheckVer Verify and process an 
acceptable check 

Check Verification and/or a Guarantee Service are 
required. 

 
Note: Each transaction is assigned a TICKET #, a unique transaction number included in all 

transaction receipts. The TICKET # is used to perform certain transaction types and to utilize 

specific features. 
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2 Install SLIM CD Software 
 
Note: To install you must be connected to the Internet 
    

2.1 Initial Installation 

 
1. Download the version of SLIM CD to your computer 

 
 
2. Click on the Setup.exe Icon to begin the installation 

 
  
3. Select “Next>” to continue installation 

 

Figure 1“SLIMCD Setup” window 

 

3. Select “Next>.”  
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End-User License Agreement screen window is displayed 
 

 

Figure 2“End-User License Agreement” Setup window 

 
4. Please read the “End-User License Agreement” carefully. 
5. Click “Yes” to accept the terms described in the “End-User License Agreement.” 
6. Click “Next>” to begin the SLIM CD installation process. 

 

 

Figure 3“Select the SLIMCD installation folder” Setup window 

 

   

 
“The SLIMCD Setup Type” window is displayed. 

 

5. “Yes” to 
accept the 
terms 
described in 
the “End-
User License 
Agreement. 

4. Please 
read the 
End-User 
License 
Agreement 

carefully. 

7.   Click “Next>.” 
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Figure 4“The SLIMCD Setup Type” window 

 
7. Select “YES” if this is a new SLIM CD account. Select “NO” If using an existing 

SLIM CD account. 
8.  Click “Next>”, You will be connected to the Internet to continue account setup.  

 
    

 

3 Bank Signup Process (only needed if you selected 
“Yes” and do not have a Client ID and Password) 

 

3.1 Complete “Merchant Signup” Form 
 
 The “Merchant Signup” screen window is displayed following installation. 

 

 

Figure 5“Merchant Signup” screen window 

7. Select “Yes or   
    “No” 

8. Click “Next>.” 

2. Follow the 
charts in 
section 3.1.1 
to complete 

this form. 

3.1.1.2 
Company 
Information 

3.1.1.1 
ResellerID / 
Bank ID # 

3.1.1.3 
Cards 

Accepted 

Note: Select the 

“Reset Values” 
button to clear 

the “Merchant 
Signup” form. 
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Follow the charts below, section 3.1.1, and enter the requested information on the 
“Merchant Signup” form to begin the Bank Signup Process. 

3.1.1 Activate your CD 

3.1.1.1 ResellerID / Bank ID # 

 
Note: Use the chart below to complete the first section of the “Merchant Signup” form: 

 
Heading:  Enter or Click: Details: 

Enter ResellerID/Bank 
ID # 

Bank ID # SLIM CD or worksheet on CD case 
sleeve. 

Would you like a 
shopping cart? 

Use pull-down menu to specify 
answer selection. 

Only E-Commerce and Mail 
Order/Phone Order merchants can 
set up a shopping cart. 

Please specify your 
credit card processing 
platform (if applicable): 

Use pull-down menu to specify 
answer selection. 

Locate on SlimCD case cover 
sleeve to identify processor of 
merchant account. 

Please specify your 
check processing 
platform (if applicable): 

Use Pull down menu to specify 
answer selection. 

Listed on Slim CD case cover 
sleeve. 

Local tax (needed for 
Shopping cart): 

Enter proper tax amount for 
your location. 

 

Note: Double-click “shopping cart documentation” to learn more about shopping carts and 

offers from SLIMCD, Inc. 

 

3.1.1.2 Company Information 

 
Note: Use the chart below to complete the next section of the “Merchant Signup” form: 

 
Heading:  Enter or Click: Details: 

Company name Enter company 
name. 

 

Business type Select from pull- 
down menu. 

Selection determines how & when SLIMCD 
software presents industry-specific data fields. 

Contact name Enter the Business 
Contact at your 
company. 

Please include Full Name & Phone/Extension 
Number. 

Address Enter company 
address. 

 

City Enter city of company 
location. 

Please do not abbreviate. 

State or 
Province(US/Canada 
only) 

Enter state or 
province of company 
location. 

Please do not abbreviate. 

Zip Enter company zip 
code. 

 

Country Enter the country 
name. 

Please do not abbreviate. 

Phone  Please include area code. 
Email address  Double check accuracy. 
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Select password Enter a password. 7 character minimum (numbers & letters can be 
mixed). 

Confirm password Enter the same 
password again. 

Double check accuracy. 

 

3.1.1.3 Cards Accepted 

 
Note: Use the chart below to complete the next section of the “Merchant Signup” form: 
 
Heading:  Enter or Click: Details: 

Visa: Click to select on the provided 
check box.  

Only check the box if the 
corresponding credit card will 
be accepted. 

Mastercard: 
Amex: 
Discover: 
JCB: 
Diners Club: 
PIN Based Debit: 

 
1. Click: Continue to Processor Setup         button when the “Merchant Signup” form 

is complete. 
2. If any information was omitted or errors are detected on the “Merchant Signup,” 

they are displayed and highlighted in RED font. Correct any errors. 
3. Press the Continue to processor setup � button.  

3.1.2 System Setup 

3.1.2.1 Checking Information 

 
1. You may be prompted to enter your checking account information. 
2. Enter the requested merchant information. Click “Continue”. 

 

 

Figure 6“Merchant Setup,” screen view for “System Setup” 

*If you are unsure 
of the information to 
enter, contact your 
bank or call Slim 
CD, Inc.’s support 

desk at 
1.877.475.4623. 
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3.1.3 System Setup  

3.1.3.1 Check Processing 

 
If processing checks with SLIM CD, a Check Processing screen will be displayed. 
1.  Enter the requested information. Select the “Submit” button. 

 

 

Figure 7 “System Setup” for Check Processing 

 
A processor-specific worksheet will be displayed. Enter the remaining merchant 
account information from the CD case sleeve.  

3.1.4 Setup Complete 

 
1. Once the series of “Merchant Setup” screens are completed, the “Setup 

Complete” screen is displayed. 
2. Locate your Client ID and instructions for initial login. 
3. Print and save the “Setup Complete” display page. 
4. Close Webpage. 
5. Within a short time, you will receive an email from support@slimcd.com 

which contains important account information. 
6. Print out and save this email as a reference.          
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Figure 8“Merchant Setup” screen for “Setup Complete” window 

 
7. Once the full installation process is complete, the “SLIMCD Setup,” 

“InstallShield Wizard Complete” is displayed. 
8. Click “Finish” to close this window. 

 

 

Figure 9“InstallShield Wizard Complete” screen window 

8. Click “Finish.” 

Note: Your 
client setup 
is finished, 
you may 
now login to 
SLIMCD 
and begin 
processing! 
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3.2 Uninstall SLIM CD Software 

3.2.1 SLIM CD Disk Method 

 
1. Re-insert the SLIM CD into your CD-ROM drive.  
2. The “InstallShield Wizard” window is displayed after a few seconds.  
3. Select “Remove” to remove all installed components. 
4. Click “Next>” to proceed.  
5.  The “Confirm Uninstall” window is displayed. 
6. Select “OK” to completely remove the SLIM CD application. 
7. A process window is displayed until the process is 100% complete. 
8. The “Maintenance Complete” screen is displayed. 
9. Select “Finish” to close the “Maintenance Complete” screen window.  

3.2.2 Add/Remove Programs Method 

 
1. Select Start > Settings > Control Panel, from the Desktop Menu Bar. 
2. Click the “Add/Remove Programs” icon on the “Control Panel” window. 
3. The “Add/Remove Programs Properties” screen window can now be viewed. 

 

 
Figure 10“Add/Remove Program Properties” window 

  
4. Select “SLIMCD” from the software list. 
5. Click the “Add/Remove” button. 
6. Click “OK” to begin uninstalling SLIMCD. 
7. The “InstallShield Wizard” screen window is displayed. 
8. Select “Remove” the SLIMCD TransClient application. 
9. Click “>Next” to proceed to the Confirmation Screen.  
10.  “Confirm Uninstall” Window is put on view. 
11. Select “OK” to confirm your selection.  
12. The “InstallShield Wizard” displays once the SLIMCD TransClient is removed. 
13. Click “Finish” to close the “InstallShield Wizard.” 
14. Click “OK.” 

4. Select 

“SLIMCD.” 
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15. Close the Control Panel window. 
 

4 Installing Optional Hardware 

4.1 Install the Card Swipe Device 

 
A card swipe device can easily be connected to your computer.  The four types of devices 
supported by SlimCD include a: keyboard card-wedge, USB card-wedge, an integrated 
PIN pad and card swipe, and an integrated check reader and card swipe.   

4.1.1 USB Swipe 

� Determine which type you have by examining the connector at the end of the card 
swipe device.  

� If there is a single flat connection, this is probably a USB connection and should 
be plugged into an open USB port on your computer.   

� The operating system should recognize the new device and automatically install 
the necessary device drivers. 

4.1.2 Keyboard Swipe 

� If there is a “Y” connector at the end of the card swipe cable, this is probably a 
keyboard wedge.   

� Unplug your keyboard.   
� Plug the keyboard swipe device into the keyboard’s position on the computer.   
� Then, plug the keyboard into the open end of the “Y” cable.   
� You do not need to install any device drivers to use the keyboard card-wedge 

devices.   
 
Note: If your computer’s keyboard uses the old-style/larger AT-style connections instead 

of the thinner PS2 connectors of the card wedge, buy adapters, both male and female 

adaptors at your local pc store, for both ends of the “Y” cable to work correctly. 

4.1.3 Serial PIN Pad Swipe 

 
� A third class of card swipe device plugs into a serial port on your computer.  
� Slim CD only supports serial card swipe devices that are part of a PIN pad (such 

as the Verifone P2000, or the MagTek IntelliPIN).   
� These devices are connected to an open serial port, and configured inside the Slim 

CD software’s Database/ Hardware Setup menu item (see the Hardware Setup 
menu). 

� If your pinpad has a 9-pin connector, but your computer only has a 25-pin 
serial port, you may purchase a 9-pin to 25-pin adaptor at any computer 
store. 

� If you do not have any available serial ports but do have an available USB, 
contact SLIM CD, Inc. or your local computer store for a Serial-to-USB 
adaptor cable. 
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4.2 Install Check Readers 

4.2.1 MICR Readers 

� Reads the number from the bottom of the check. 
� The MICR readers are available in Keyboard, Serial, or USB configurations.  
� Note: Not all MICR readers have the built-in card swipe device, so be sure to 

select the correct model for your needs. 

4.2.2 Check Image Scanner 

� Scans an image of the entire check. 
� Available in serial or USB configurations.   
� Not all imagers have the card swipe device built into the unit, so be sure to select 

the correct model if you wish to process credit card transactions.  
� Certain imagers require the software that comes with the imager to be installed 

prior to use by SLIM CD. 

4.3 Install a Receipt Printer 

Note: You may use either your standard desktop printer or a special receipt printer with 

the Slim CD software.   

4.3.1 Select Standard Desktop Printer 

� Use the “Hardware Setup” menu item under the “Database” pull-down menu.   
� Use the printer drop down menu on the right to select your desktop printer. 

4.3.2 Select Special Receipt Printer  

� Connect the printer to your computer.   
� Locate the printer cable for the receipt printer, and connect it to your computer.   
� Printers usually connect to either an LPT# port or to a COM# port.   
� Identify which port you have available for your receipt printer and connect the 

cable to the printer and the computer. 

4.3.3 Configure Windows to Recognize Printer 

� To do this, you may need to install a special print driver.   
� If your printer came with a CD or diskette containing print drivers for Microsoft 

Windows, then install those print drivers.   
 

4.4 Install Generic Text Print Driver 

 

Note: This driver should work with any receipt printer.  
� Click “Start/Settings/Printers” menu option > “Add Printer.” 
� Use the Wizard and specify “Local Printer.”   
� Select the port where your new printer is attached, the word “Generic” in the list 

of manufacturers, and “Generic/Text Only” in the list of printers.  
� Continue with the wizard until finished and print a test page to verify a correct 

port selection and installation of the driver. 
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4.4.1 Install a Verifone P-250/900, Ingenico Scribe 

� First, complete the setup of the Generic Text printer. 
� Right-click on the printer and select “Properties” from the menu.    
� A dialog box of options should be displayed.  

 
Note: If you have selected a COM port for your device, click on the “Ports” tab and click 

on the “Configure Port” button to specify the following communications protocol: 

 

1. Set the “Bits per second” to “9600.” 

2. Set the “Data Bits” to “7.” 

3. Set the “Parity” to “Even”. 

4. Set the “Stop Bits” to “1.” 

5. Set the “Flow Control” to “Hardware.” 

 
� Select the “Advanced” tab (or the “Spool Settings” button) and click on the button 

to “Print Directly to Printer.” 
 

4.4.2 Epson, Axiohm, and Other Printers 

 
� Install the print driver that came with the printer according to the manufacturer’s 

instructions.  
� Select printer name from the list of available printers in the “Hardware Setup.” 

4.4.3 Install a PIN Pad Device 

 
Note: Some computers may not have an open serial (COM) port, but do have an open 

USB port.  If this is the case, contact Slim CD for a serial-to-USB adaptor cable. 

 

� Connect the PIN Pad to a serial or USB port.   
� Configure the Slim CD software to use the PIN Pad.  See the “Database” menu’s 

“Hardware Setup” item in this manual for more information. 
 
Note: In some cases, the Pin Pad needs to be connected to the USB port.  If necessary, purchase a 

SERIAL-TO-USB device with any other serial peripheral you might have on a COM port, and 

connecting the Pin Pad directly to the COM port. 

These devices are sold by outside vendors and can be difficult to connect. 

If you do not have any serial ports on the computer at all, then the SERIAL-TO-USB converter 

must be used. 
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4.4.4 Install the ePad Software 

 
� If you are using the ePad (Electronic Signature Capture Pad), you must install the 

drivers for the ePad device.  
� Locate the driver on the SLIM CD-ROM in a folder named “ePad.” 
 

4.4.4.1 Operating System Sub-Folders 

 
� There are sub-folders for each operating system supported: 

 
Operating System Sub-Folders 
Windows NT drivers are located in the \ePad\NT40 folder. 
Windows ME drivers are located in the \ePad\WinME folder 
Windows 2000 drivers are located in the \ePad\Win2000 folder 
Windows 95/98 drivers are located in the \ePad\Win9x folder 
Windows XP driver for ePad needs an update to function properly. 

 
� For Windows 95, use ePad with COM1, COM2, INT 4, and Memory Address 

Range 03F8-03FF for best results. 
� Windows NT and Windows 2000 users that experience problems with ePad 

should make sure that the WINTAB32 service has been started.  
� Windows NT users can find the Services item in the Control Panel.  
� Windows 2000 users can find the Services item by clicking on the Administrative 

Tools item in the Control Panel. 
 

4.4.4.2 Update to Windows XP driver for ePad  

� Contact Interlink Electronics, Inc. to verify current available update at 
1.800.340.1331 or (805) 484-1331. 

� Go to interlinkelec.com. 
� Click “Support” on the top menu bar.  
� Then click “Download Drivers.”   
� Next, download the “epad Driver Universal Installer.” 

 

4.4.4.3 After the Drivers are Installed: 

� Connect your ePad to the appropriate COM or USB port. 
� Then, reboot your computer.   
� The ePad is working, if it moves the cursor on your screen the same way the 

mouse does. 
 
 
 



SLIM CD, Inc.                              Phone: 1.877.475.4623                              Email: support@slimcd.com 

Desktop User Guide  2008                            Page 27 of 146                                             

www.slimcd.com 

 

5 SLIM CD User Interface 

5.1 Logon to SLIM CD Software 

 
1. Activate your SLIM CD software. 
2. The SLIM CD will check for an active Internet connection. 
3. The “TransClient Logon” screen is displayed. 
4. Enter your User Name, ClientID, and Password. 
5. Select the “Logon” button. 

 

 

Figure 11“TransClient Logon” screen window 

 

5.2 View TransClient- ADMIN Menu  

 
The “TransClient- ADMIN” Menu will be displayed. 
 

 

Figure 12“TransClient- ADMIN” Menu display

Note: The company 

owner or the person in 

charge of transactions is 

the administrator and 

their User Name is 

ADMIN. Clerks log in 

with a unique User Name 

assigned by the  

administrator for your 

computer. 

Enter User 
Name, 
ClientID,  & 
Password. 
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6 SLIM CD TransClient Menus  
  

6.1 DialUp 

6.1.1 Dial/Up 

1. Display the “TransClient-ADMIN Menu,” as detailed in Section 5 of this 
document. 

2. From the menu bar, click the “DialUp” pull-down menu to establish or check an 
Internet connection. 

3. Select to highlight your regular Dial-Up connection to avoid any charges. 
4. Click “CheckConn.” 

 

Note: If your Internet service provider is unavailable, select the SLIM CD entry for backup dial-

in-service. If SLIM CD is selected, you are making a long-distance toll call. Disconnect 

immediately after your transaction is complete. 
 

 

Figure 13“DialUp Networking Phone Book Entries” window 

 

6.1.2 Add Dial-Up Networking (DUN) Phone Book Entries 

 
1. Select “Add Entry” to display the “New Connection Wizard” screen window. 
2. Click the “Type of Connection” of the new entry. 
3. Press “Next>” to proceed. 

 

Note: Login 

is only active 

if your 

Internet 

connection is 

lost. 

 

Verified active 

Internet Connection. 

Note: All 

buttons are 

available 

online and 

offline, when 

the Dial-Up 

network is 

installed. 



SLIM CD, Inc.                              Phone: 1.877.475.4623                              Email: support@slimcd.com 

Desktop User Guide  2008                            Page 29 of 146                                             

www.slimcd.com 

 

 

Figure 14“New Connection Wizard” screen window 

 
4. Enter the name for the computer you are dialing: Ex. My Connection. 
5. Select a device that will be used to Dial-Up. 
6. Click “Configure” if you need to establish the selected device with your 

connection to the Internet. 
7. Select “Next>” to continue. 

 

        

Figure 15“Make New Connection” screen views 

 
8. Enter the “Area code” and “Telephone number” for the computer you want to 

call. 
9. Type the “Country or region code” for the computer you wish to call. 
10. Then Click “Next>.” 
11. Last, select “Finish.” Reestablish Internet Connection 

 
Note: The SLIM CD enables you to reconnect to your Internet service provider, or to use the 

SLIM CD backup Internet connection with your modem.  

 
1. If you lose your Internet connection, the “Dial-Up SLIMCD” Phonebook entry to 

client screen is displayed. 
2. The names of established Internet Dial-Up Accounts and SLIMCD are listed.  

 

Note: Your screen may 

look slightly different 

depending on which 

version of Windows 

you use. 

7. Select “Next> to Use the pull-down menu 

tabs to make your selection. 

Telephone Number Entry 
Sample: 475-4516 
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Figure 16Dial-Up SLIMCD window 

 
Note: The SLIM CD selection does not require a dialed area code or a “1” to designate long 

distance before dialing. 

 

Note: If you have dialing requirements other than what is presented (such as dialing to get an 

outside line, or turning off call-waiting), or if you are running on Windows 2000, you must create 

your own CUSTOM phone book entries if you want to connect directly to SLIM CD as an 

emergency backup. 

 
3. Once you have made your selection, the screen displays the Phonebook entry. 

 

 
 

4. Select Dial to “Dial-Up” and establish an Internet Connection. 
 

Note: Using the SLIM CD backup choice will probably incur long distance charges. 
SLIM CD, INC. is not responsible for any long distance or other telephone-related 
charges associated with using its backup system. 
 
 

1. Click “Home” to view the “TransClient” home menu display. 
2. Use the displayed phone number for SLIM CD, for questions or assistance. 
3. Use any item on the menu bar to continue using the “TransClient” on SLIM CD.  

 

 

Figure 17“Home screen" window display 

Note: SLIM 

CD Phone 

Number for 

assistance. 
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6.1.3 Exit 

1. Select “DialUp” from the pull-down menu. 
2. Then click “Exit” to close the “TransClient” menu and exit SLIM CD. 

 
Note: If you are on the Internet using a dial-up connection, the software does not automatically 

disconnect. Exit and Disconnect Windows NT by selecting DISCONNECT.  

Windows 95/98 users are not prompted and must use Disconnect on the Dial-Up menu, 
or by standard modem icons located on the desktop. 

6.2 Transactions 

6.2.1 Process A Credit Card Transaction, VPOS 

6.2.1.1 Payment Details 

 
1. Display the “TransClient” menu. 
2. Select “Transactions > VPOS” from the TransClient menu bar. 

 

 

Figure 18“TransClient-ADMIN” screen display 

 
Note: The VPOS (Virtual Point of Sale) screen is divided into two sections: Payment Details 
and Cardholder Details. The Payment Details section is always displayed.  

The Cardholder Details section is only displayed when a cardswipe device or Pinpad hardware is 

not in use, or when the card number is manually entered using the keyboard. 
 

3. Click “Credit Card” in the “Payment” type box window. 
4. Select a “Trans Type” (Transaction Type) fro the pull-down tab: 

 
Options Transaction Types 

Auth Holds funds on a credit card for a period of time. 
Force Charges the credit card the amount that was held in the Auth. 
Sale Places a charge on a credit card. 

Select 
“Transactions 
> VPOS.”  

Note: The 

current User 

Name is 

displayed in 

the title bar of 

the window. 
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Credit Returns funds from your account to the credit card. 
Void Voids out a Sale/Force transaction if the batch has not been closed. 

 

Note: When a clerk logs in, the Trans Type list only contains transaction types for which 
the clerk has permission to perform. 
 
Note: The Cardholder Details section is only displayed when a cardswipe device or Pinpad 

hardware is not in use, or when the card number is manually entered using the keyboard. 

5. Enter the exact amount. Example: $25.00.   
6. Verify that the amount is correct on the Payment Details tab. 
7. Enter the Credit Card Information manually or by swiping the card.  

Note: Swiping the card will cause the transaction to be processed immediately. 

Note: Note: A message will be displayed if any additional data is required for keyed transactions 

(such as the CVV2 or address information). 
 

8. Enter the credit “Card #” and “Expdate” (Expiration Date).   
9. Click the “Submit” to process the transaction.   
10. Wait a few moments…for the transaction to be sent to SLIM CD to be approved 

or declined. 
11. If the transaction is approved the screen will clear, and the previously 

selected/configured printer, will print a receipt automatically.  
12. If the transaction is approved, but you have not configured a printer, the 

“Approved Transaction…” Receipt screen is displayed. 
 

 

Figure 19“Approved Transaction” Receipt displayed 

13. If the transaction is declined, the TransClient window is generated. 
 

 

Figure 20“TransactionClient, Decline:N” window 

Note the 
reason for 

the 

DECLINE. 

The transaction can be 
resubmitted using a 
different credit card. 
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6.2.1.2 Transaction Responses and Receipt Data 

 
Responses from the SLIM CD system contain a number of important data.  
Most of this data is broken down on the receipt.   
 

Codes Approval Indicator  

Y An Approved Transaction 
N A Declined Transaction 
D A disallowed transaction due to fraud scrubbing 
E E indicates an error processing the transaction 

 

 

6.2.1.3 Authorization Codes and Decline Descriptions 

� SLIM CD will generate an AuthCode or a decline/error description.   
� The AuthCode is a 6-digit value from the cardholder’s bank, indicating that 

the transaction has been successful.   
� A decline/error description is a short phrase that informs you the transaction 

has either been declined, or has not been processed. 
 

6.2.1.4 AVS Response 

 
� The last pair of letters in a response indicates two separate responses, one for 

AVS and one for CVV2. 
� The first letter is the AVS from the Address Verification System. 
� The first letter provides information on how the manually entered address 

information matches the information stored at the cardholder’s bank.   
 

Single 
Letter  

AVS Reply 
Note: for cards issued in the U.S. 

A Address Only 
B Street Match 
E Error 
M Address Match 
N No Match 
R R – Retry 
S S - Service Unavailable 
U Unavailable 
W Whole Zip Match 
X Exact Zip & Address Match 
Y Zip Address Match 
Z Zip Match Only 
Space Not Processed for card swipe transactions 

 



SLIM CD, Inc.                              Phone: 1.877.475.4623                              Email: support@slimcd.com 

Desktop User Guide  2008                            Page 34 of 146                                             

www.slimcd.com 

 

6.2.1.5 CVV2 and CID 

 
Note: If the customer’s card can’t be swiped, isn’t present, or more security is needed, the CVV2 

or CID option can be used. 

 

Note: CVV2/CID is an authentication device established by the credit card companies in an 

effort to reduce fraud. 

 

1. Locate the CVV2, Card Verification Value for most credit cards, or the CID 
number on the American Express charge card.  

2. If requested, enter either the CVV2/CID number in the tab on the “TransClient” 
screen- during the transaction. 

 

  
 

 
 
 
 

 
 
 
 
 
 
 

3. The SLIM CD software will then process the completed transaction and generate 
a response: 

 
CVV2 Responses 

M CVV2 Match 
N CVV2 Does not 

match 
P CVV2 Not Processed 
S Service Unavailable 
Space Not Processed for 

swipe transactions 
 

Note: If the card does not contain a CVV2/CID number and CVV2 

is required for this transaction, you should select the CVV2 NOT 

on card checkbox, which enters the word NONE as the CVV2.  

 

Note: If the CVV2 value appears illegible on the card, leave the 

CVV2 field empty, if possible. If not, request that the customer use 

another card or another form of payment. 

 

The 3-digit number at 
the end of the 
signature area on the 
back of most 
Visa/Mastercard credit 
cards. 

The 4-digit number 
embossed on the 
front of the card. 
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ePad Selection 

 
1. A signature window is displayed when a Sale, Credit, or Void is approved. 

 

 

Figure 21“ePad Signature Window” display 

 
2. Ask the customer to sign the signature prompt using the ePad.  
3. Click “OK.”  
4. The “Approved Transaction Receipt” screen will open. 
5. In case of an error, click on the signature to redisplay the signature capture, 

allowing your customer to re-sign the document. 
 

 

Figure 22“Approved Transaction Receipt” displayed 

 
Note: The Slim CD will store the signature in the database as part of the transaction and for 

future comparisons. 

 
 
 
 
 
 
 
 

 

 

Troubleshooting 
If the signature window fails to appear on Windows NT or Windows 2000: 

� Start the WINTAB32 service by using the “Services” selection of the Control Panel. 

� Click “Print Receipt” (2 copies for your records) to print on your default printer.  

� The signature appears on receipts that support printing graphics.  

� Text-only printers (ex. Citizen Dot-Matrix) do not print the signature as part of the 

receipt.  

� Click “OK” to complete the transaction without printing a receipt. 



SLIM CD, Inc.                              Phone: 1.877.475.4623                              Email: support@slimcd.com 

Desktop User Guide  2008                            Page 36 of 146                                             

www.slimcd.com 

 

6.2.2 Process A Check Transaction, VPOS 

 
Note: Mandatory payment detail fields depend on the service type provided by the check 

processor.  

 

6.2.2.1 Payment Details 

1. Display the TransClient” menu.  Select “Check” in the payment field. 
 

 

Figure 23"TransClient-ADMIN" screen display 

 
2. Use the pull-down menu to select the “Trans Type.” 
3. Select one of the following: 

 

 

Traditional Paper Check Product 
Trans Type Details 

CHECKVER Allows merchant to input consumer’s MICR and/or Driver’s license 
information and transmitted to a database where it can be 
validated, matched against return check and negative file data, 
and authorized after successfully passing through risk decision 
systems.  

 

For Electronic Check Conversion- (allows merchants to obtain a check authorization 

resulting in the creation of a one-time electronic debit (EFT) to the customer’s 

checking account.) 

 
Trans Type  Details 

SALE If you are setup for ECC: Used in conjunction with an 
electronic MICR reader to obtain check conversion 

Select 
“Transactions 
> VPOS.” 
Payment, 
Check. 

 

Note: The 

current User 

Name is 

displayed in 

the title bar 

of the 

window. 
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authorization.  Approved converted transaction will generate a 
conversion authorization receipt.  The consumer must sign the 
authorization receipt.  Merchants must stamp the original check 
“VOID” and return the voided check along with a copy of the 
conversion receipt to the consumer.  
 
If you are ECC conversion only: This option allows merchants 
to process check transactions which are not put through any 
authentication or risk decision process.  The sole purpose of this 
product is to transmit the check transaction information to the 
bank where an ACH file will be created and transmitted to the 
ACH network for settlement.  Conversion Sale and Conversion 
Void are the only transaction type available with the ElecCheck 
Conversion only product.   

VOID Voids a previously authorized Check Conversion Sale 
transaction.  Used in the event of a return or when a consumer 
refuses to sign the check conversion authorization receipt.  
Successfully voided transactions generate VOID confirmation 
receipts, and one copy should be provided to the consumer.    

AUTH Used to obtain a check authorization only for items that do not 
qualify for conversion under the NACHA program.  Ex. Foreign 
checks, corporate checks, travelers check.  Approved 
transactions will not generate a conversion receipt nor result in a 
one-time debit.  All checks approved must be physically taken to 
the bank for deposit.  (If you are setup for conv. only, Auth 
will not appear as a transaction type) 

 
4. Click to choose if the check is a “business check.”  
5. Select the “Print Options” to print one copy, two copies, or none/no print after the 

transaction for the receipt. 
6. Under the heading “Payment Details,” enter the total “Amount $.” 

 
Note: Swipe the check or enter all of the required information manually.  Each type of 

check service has a different set of requirements when entering the information manually.  

For services that require information from the customer’s drivers license, the information 

can be retrieved with a magnetic stripe reader or bar code reader. 

 
7. For FM1 service, enter the Check #, Accounting #, and Routing #. 

For FM2 service, enter the Check #, Accounting #, Routing #, Drivers License #, and 
Date of Birth 
For ID Free service, enter the Check #, Accounting #, Routing #, then the merchant may 
be prompted to enter Drivers License #, and Date of Birth 

For DL service, enter the Drivers License # 
For DL Check No. service, enter the Drivers License #, and Check # 
For C.O.D. service, enter the Phone #, and Zip Code 

 
Note:  The “Account #” and “routing #” are located on the bottom  of the check.  The 

“Check#” is printed on the top right corner of the actual check.   

Note:  To enter a birth date, put it in (mmddyy) format. 
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8. In the check holder details screen, use the customer’s Driver’s License to enter 
and/or use the pull-down menu to fill in the customer’s First name, Last name, 
Address, City, State/Prov., Zip, Country, Phone, and Email.  (Optional) 

9. Click Submit to send the transaction for processing. The SLIM CD network will 
route the transaction to process for authorization.  An approval screen will display 
if the transaction went through. 

10. If attempting a void on a check transaction, enter the ticket# for the transaction. 
 

Traditional Paper Check Product (PC) 

Electronic Check Conversion (ECC) 

 

Check service Requirements 

FM1 (PC, ECC) Check #, Accounting #, Routing # 

FM2 (PC, ECC) Check #, Accounting #, Routing #, Drivers License #, Date of Birth 

IDFree (PC) Check #, Accounting #, Routing #, then the merchant may be prompted to 
enter Drivers License #, Date of Birth 

DL (PC) Drivers License # 

DL Check No. 
(PC) 

Drivers License #, Check # 

C.O.D.  (PC)  7-digit Phone #, & 5-digit Zip Code 

 
 

Meaning of codes for ECC 
Code 1-  In most instances this is based upon negative information on file, usually prior 
unpaid checks. 
 
Code 2-  Although no unpaid check information is on file, Certegy did not have sufficient 
information available to approve the transaction, or this transaction exceeded a pre-
established limit.  
 
Code 3-  The format of the identification presented did not conform to government 
established guidelines for a valid ID. 

6.2.3 Processing a Gift Card Transaction, VPOS 

6.2.3.1 Payment Details 

1. Display the “Trans Client” menu 
2. Select “Transactions > VPOS” from the TransClient menu bar 
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 Figure 24 "TransClient-ADMIN" screen display 

3. Use the drop down menu in the payment field and select Gift Card 
4. Select a transaction type from the pull down menu 
5.  

 

Options Transaction Type 

Sale Sell a gift card and initially place dollar amount on the card 

Activate To activate a card and initially place dollar amount on the card 

Add To dollar amount to an already established card 

Balance Shows the remaining balance on a card 

Deactivate To cancel a current gift card number 

Replace Use this option to replace a card if original is lost or stolen 

Void Voids out a transaction completed with a gift card  

 
5. Enter the card number, either manually or by swiping the card 
6. For sale, activation, addition, and void, enter the amount of gift card dollars  

to be used in the transaction 
7.   Click the submit button to process the transaction 

 

6.2.4 Processing a Loyalty Card Transaction, VPOS 

 

6.2.4.1 Payment Details 

 
1. Display the “Trans Client” menu 
2. Select “Transactions > VPOS” from the TransClient menu bar 
3. Use the drop down menu in the payment field and select Loyalty Card 

Select 
Gift Card 
 
Select  
Trans 
Type 
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Figure 25"Trans-client ADMIN" screen display 

 
4. Select a transaction type from the pull down menu 

Options Transaction Type 

Activate To activate a card and initially place reward points on the card 

Add To add points to an already established card 

Balance Shows the remaining point balance on a card 

Deactivate To cancel a current loyalty card number 

Redeem To use points on a card for redeemed awards or promotions 

Replace Use this option to replace a card if original is lost or stolen 

Void Voids out a redemption  

 
5. Enter the card number, either manually or by swiping the card 
6. For activation, addition, and void, enter the amount of reward points to be used in 

the transaction 
7. Click the submit button to process the transaction 

 

6.2.5 Processing an Electronic Benefits Transfer Card Transaction, VPOS 

 

6.2.5.1 Payment Details 

 
1. Display the “Trans Client” menu 
2. Select “Transactions > VPOS” from the TransClient menu bar 
3. Use the drop down menu in the payment field and select EBT Card 

Select 
Loyalty 
Card 
 
Select 
Trans 

Type 
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4. Select a transaction type from the pull down menu 

Options Transaction Type 

Sale Place charge from the EBT into your account 

Credit Returns funds from your account to the EBT 

 
5. Select the type of Electronic Benefits Transfer to be processed 

Options Transaction Type 

Food Stamps State sponsored benefits for food items 

CD Purchase Receiving cash back off of a non-food stamp EBT card  

Cash Benefits Making a purchase off of a welfare card, SS card, etc. 

 
 

 

 

Figure 26"TransClient-ADMIN" screen display         

 
6. Enter the exact amount 
7. Verify that the amount is correct on the payment details tab 
8. Enter the card information (card # & expiration date) manually or by swiping the 

card. 
for food stamps:  Enter the voucher number 

 for  CD Purchase:  Enter the cash back amount 
9. Click the submit button to process the transaction 

Select 
EBT 
card 
 
Select 
trans 
Type 
 
Select 
type of 

EBT 
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10. Wait a few moments for the transaction to be sent to SLIM CD to be approved or 
declined. 

11. If the transaction is approved the screen will clear, and the previously 
selected/configured printer, will print a receipt automatically. 

12. If the transaction is approved, but you have not configured a printer, the 
“Approved Transaction…” Receipt screen is displayed 

 
 
 
 
 
 
 
 
 
 
 
 
 

6.3 Industry Specific Transactions (Retail) 

 
 

 

Figure 27"TransClient-Retail" screen display 
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Retail 

 

 

Auth 

 
1.) Select “Transactions > VPOS” from the TransClient menu bar 
2.) Select Credit Card as the payment type 
3.) Select AUTH from the trans type pull down tab 
4.) Key the transaction amount under payment details 
5.) Swipe card or key the card #, Expdate, and CVV2 under payment details 

• If card is swiped the transaction will automatically submit  
6.) If the card is not swiped key any cardholder details needed 
7.) Click submit at the bottom for the screen 

 

Sale 

 
1.) Select “Transactions > VPOS” from the TransClient menu bar 
2.) Select Credit Card as the payment type 
3.) Select SALE from the trans type pull down tab 
4.) Key the transaction amount under payment details 
5.) Swipe card or key the card #, Expdate, and CVV2 under payment details 

• If card is swiped the transaction will automatically submit  
6.) If the card is not swiped key any cardholder details needed 
7.) Click submit at the bottom of the screen 

 

Credit 

 
1.) Select “Transactions > VPOS” from the TransClient menu bar 
2.) Select Credit Card as the payment type 
3.) Select CREDIT from the trans type pull down tab 
4.) Key the transaction amount under payment details 
5.) Swipe card or key the card #, Expdate, and CVV2 under payment details 

• If card is swiped the transaction will automatically submit 
6.) Ticket # from the original transaction must be entered under payment details 
7.) If the card is not swiped key any cardholder details needed 
8.) Click submit at the bottom of the screen 

 
 
 

Transaction  Transaction Function 

Auth Holds funds on a credit card for a period of time. 

Force Charges the credit card the amount that was held in the Auth. 

Sale Places a charge on a credit card. 

Credit Returns funds from your account to the credit card. 

Void Voids out a Sale/Force transaction if the batch has not been closed. 
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Force 

 
1.) Select “Transactions > VPOS” from the TransClient menu bar 
2.) Select Credit Card as the payment type 
3.) Select FORCE from the trans type pull down tab 
4.) Key the transaction amount under payment details 
5.) Swipe card or key the card #, Expdate, and CVV2 under payment details 
6.) Ticket # from the original transaction must be entered under payment details 
7.) If the card is not swiped key any cardholder details needed 
8.) Click submit at the bottom of the screen 

 

Void 

1.) Select “Transactions > VPOS” from the TransClient menu bar 
2.) Select Credit Card as the payment type 
3.) Select VOID from the trans type pull down tab 
4.) Key the transaction amount under payment details 
5.) Swipe card or key the card #, Expdate, and CVV2 under payment details 
6.) Ticket # from the original transaction must be entered under payment details 
7.) If the card is not swiped key any cardholder details needed 
8.) Click submit at the bottom of the screen 

 

Reports 

 

1.) Select Transactions > Stats from the TransClient menu bar 
2.) Select Transaction type to search for and any additional search parameters 

desired 
3.) Select the search transactions button and any transactions matching the search 

criteria will be displayed  

 

Note: Users cannot view transactions ran by the admin and by default cannot view 
transactions ran by any other users.  For a user to be able to see other user’s transactions 
view other has to be checked under that user’s setup. 

 

Adding clerks to the desktop client 

 

This can only be done when logged in as Admin. 
1.) Select Database > Users Setup from the TransClient menu bar 
2.) Key in the user information and the ID 
3.) Enter the users password and select the transaction types allowed 
4.) Then click the add button and the user should now be displayed as a user under 

user setup 
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6.4 Industry Specific Transactions (E-commerce) 

 
 

Figure 28  TransClient-E-commerce” screen display 

 

E-Commerce    
  

  

  
 Auth 
  

1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select AUTH from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

Transaction     Transaction Function    
Auth Holds funds on a credit card for a period of time. 
Force Charges the credit card the amount that was held in the Auth. 
Sale Places a charge on a credit card. 
Credit Returns funds from your account to the credit card. 
Void Voids out a Sale/Force transaction if the batch has not been closed. 



SLIM CD, Inc.                              Phone: 1.877.475.4623                              Email: support@slimcd.com 

Desktop User Guide  2008                            Page 46 of 146                                             

www.slimcd.com 

 

•        If card is swiped the transaction will automatically submit  
6.)    If the card is not swiped key any cardholder details needed 
8.) Click submit at the bottom for the screen 
 

  

Sale 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select SALE from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit  
6.)    If the card is not swiped key any cardholder details needed 
7.)    Click submit at the bottom of the screen 

  

Credit 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select CREDIT from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 
8.)    Click submit at the bottom of the screen 

  
  
  

Force 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select FORCE from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 
8.)    Click submit at the bottom of the screen 

  

Void 

1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select VOID from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
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5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 
8.)    Click submit at the bottom of the screen 

  

Reports 

  

1.)    Select Transactions > Stats from the TransClient menu bar 
2.)    Select Transaction type to search for and any additional search parameters 

desired 
3.)    Select the search transactions button and any transactions matching the search 

criteria will be displayed  

  

Note: Users cannot view transactions ran by the admin and by default cannot view 
transactions ran by any other users.  For a user to be able to see other user’s transactions 
view other has to be checked under that user’s setup. 

  

Adding clerks to the desktop client 

  

This can only be done when logged in as Admin. 
1.)    Select Database > Users Setup from the TransClient menu bar 
2.)    Key in the user information and the ID 
3.)    Enter the users password and select the transaction types allowed 
4.)    Then click the add button and the user should now be displayed as a user under 

user setup 

  
 
 



SLIM CD, Inc.                              Phone: 1.877.475.4623                              Email: support@slimcd.com 

Desktop User Guide  2008                            Page 48 of 146                                             

www.slimcd.com 

 

6.5 Industry Specific Transactions (Hotel) 

 

Figure 29  TransClient-“Hotel” screen display 

 
 

 

Hotel    
  

  
  
 Auth 
  

1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select AUTH from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit  
6.)    If the card is not swiped key any cardholder details needed 
7.)    Click submit at the bottom of the screen 
8.)    Screen will prompt to please fill out additional hotel info 
 

Transaction     Transaction Function    
Auth Holds funds on a credit card for a period of time. 
Force Charges the credit card the amount that was held in the Auth. 
Sale Places a charge on a credit card. 
Credit Returns funds from your account to the credit card. 
Void Voids out a Sale/Force transaction if the batch has not been closed. 
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Figure 30  TransClient-“Hotel Info” screen display 

 
9.)    Key the folio, check in time, special program code, and reason extra charges if 

needed 
10.)   Click OK or press enter and the transaction will be processed 

  

Sale 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select SALE from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit  
6.)    If the card is not swiped key any cardholder details needed 
7.)    Click submit at the bottom of the screen 
8.)    Screen will prompt to please fill out additional hotel info 
9.)    Key the folio, check in time, special program code, and reason extra charges if 

needed 
10.)   Click OK or press enter and the transaction will be processed 

  

Credit 

  

1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select CREDIT from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 
8.)    Click submit at the bottom of the screen 
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9.)    Screen will prompt to please fill out additional hotel info 
10.)    Key the folio, check in time, special program code, and reason extra charges if 

needed 
11.)   Click OK or press enter and the transaction will be processed 

  

Force 
  

1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select FORCE from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 
8.)    Click submit at the bottom of the screen 
9.)    Screen will prompt to please fill out additional hotel info 
10.)   Key the folio, check in time, special program code, and reason extra charges if 

needed 
11.)   Click OK or press enter and the transaction will be processed 
 

  

 

Void 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 
3.)    Select VOID from the trans type pull down tab 
4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 
8.)    Click submit at the bottom of the screen 
9.)    Screen will prompt to please fill out additional hotel info 
10.)        Key the folio, check in time, special program code, and reason extra charges if 
needed 
11.)    Click OK or press enter and the transaction will be processed 

  

Reports 

  

1.)    Select Transactions > Stats from the TransClient menu bar 
2.)    Select Transaction type to search for and any additional search parameters 

desired 
3.)    Select the search transactions button and any transactions matching the search 

criteria will be displayed  
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Note: Users cannot view transactions ran by the admin and by default cannot view 
transactions ran by any other users.  For a user to be able to see other user’s transactions 
view other has to be checked under that user’s setup. 

  

Adding clerks to the desktop client 

  

This can only be done when logged in as Admin. 
1.)    Select Database > Users Setup from the TransClient menu bar 
2.)    Key in the user information and the ID 
3.)    Enter the users password and select the transaction types allowed 
5.) Then click the add button and the user should now be displayed as a user under 

user setup 
 

6.6 Industry Specific Transactions (Restaurant) 

 

 

Figure 31  TransClient-“Restaurant” screen display 

 

Restaurant 

  

Transaction  Transaction Function 

Auth Holds funds on a credit card for a period of time. 
Sale Places charge on a credit card. 

Tipedit Allows you to add a tip to a Sale or Force transaction 

Force Charges the credit card the amount that was held in the Auth. 
Credit Returns funds from your account to the credit card. 
Void Voids out a Sale/Force transaction if the batch has not been closed. 
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Auth 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select AUTH from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Tip can be added to the auth 

•        If a tip is added to the auth the receipt will not show the added amount 
and print a blank tip line for the customer to enter the tip desired  

6.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit  
7.)    If the card is not swiped key any cardholder details needed 

8.)    Click submit at the bottom for the screen 

  

Sale 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select SALE from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Tip can be added to the sale 

•        This will add the tip to the sale and print the tip amount on the receipt 
6.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit  
7.)    If the card is not swiped key any cardholder details needed 

8.)    Click submit at the bottom of the screen 

  

Tipedit 

 

1.) Select “Transactions > Stats” from the TransClient menu bar 
2.) Search for the transaction for which a tip should be added to 
3.) Once the transaction is located, double click the transaction 
4.) Press the VPOS button on the transaction details screen  
5.) Select “Tipedit” from the transaction type drop down menu 
6.) Enter the dollar amount of the tip into the Tip field 
7.) Press the submit button 

Note:  Tips may only be added towards transactions which are classified as sales or 

forces.  Do not change any figure in the amount field when adding a tip to a 

transaction 

 
 
 

 



SLIM CD, Inc.                              Phone: 1.877.475.4623                              Email: support@slimcd.com 

Desktop User Guide  2008                            Page 53 of 146                                             

www.slimcd.com 

 

 
 

  

Force 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select FORCE from the trans type pull down tab 

4.)    Key the transaction amount and tip under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 

       8.)  Click submit at the bottom of the screen 
 

Credit 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select CREDIT from the trans type pull down tab 

4.)    Key the transaction amount and tip under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 

       8.)    Click submit at the bottom of the screen 

  

Void 

1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select VOID from the trans type pull down tab 

4.)    Key the transaction amount and tip under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 

8.)    Click submit at the bottom of the screen 

  

Reports 

  

1.)    Select Transactions > Stats from the TransClient menu bar 
2.)    Select Transaction type to search for and any additional search parameters 

desired 

3.)    Select the search transactions button and any transactions matching the search 
criteria will be displayed  
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Note: Users cannot view transactions ran by the admin and by default cannot view 
transactions ran by any other users.  For a user to be able to see other user’s transactions 
view other has to be checked under that user’s setup. 

  

Adding clerks to the desktop client 

  

This can only be done when logged in as Admin. 
1.)    Select Database > Users Setup from the TransClient menu bar 
2.)    Key in the user information and the ID 

3.)    Enter the users password and select the transaction types allowed 

4.) Then click the add button and the user should now be displayed as a user under 
user setup 

 
 

 

 

 

6.7 Industry Specific Transactions (Mail Order) 

 

 

Figure 32  TransClient-“Mail Order/Direct Marketing” screen display 
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Mail Order / Direct Marketing 

  

 Auth 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select AUTH from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit  
6.)    If the card is not swiped key any cardholder details needed 

7.)    Click submit at the bottom for the screen 
8.)   Does not auto print receipt, screen is shown. 
9.)   Select “EmailReceipt” to have the receipt emailed. 

 

Figure 33  TransClient-“Mail Order/Direct Marketing” receipt display 

Transaction 

Types 

Transaction Function 

Auth Holds funds on a credit card for a period of time. 
Force Charges the credit card the amount that was held in the Auth. 
Sale Places a charge on a credit card. 
Credit Returns funds from your account to the credit card. 
Void Voids out a Sale/Force transaction if the batch has not been closed. 
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 Sale 
  

1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select SALE from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit  
6.)    If the card is not swiped key any cardholder details needed 

7.)    Click submit at the bottom of the screen 

  

Credit 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select CREDIT from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 

8.)    Click submit at the bottom of the screen 

  
  
  

Force 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select FORCE from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 

8.)    Click submit at the bottom of the screen 

  

Void 

1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select VOID from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 

8.)    Click submit at the bottom of the screen 
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Reports 

  

1.)    Select Transactions > Stats from the TransClient menu bar 
2.)    Select Transaction type to search for and any additional search parameters 

desired 

3.)    Select the search transactions button and any transactions matching the search 
criteria will be displayed  

  

Note: Users cannot view transactions ran by the admin and by default cannot view 
transactions ran by any other users.  For a user to be able to see other user’s transactions 
view other has to be checked under that user’s setup. 

  

Adding clerks to the desktop client 

  

This can only be done when logged in as Admin. 
1.)    Select Database > Users Setup from the TransClient menu bar 
2.)    Key in the user information and the ID 

3.)    Enter the users password and select the transaction types allowed 

4.)    Then click the add button and the user should now be displayed as a user under 
user setup 

  

 
 
 

6.8 Industry Specific Transactions (Auto Rental) 

 

Figure 34  TransClient-“Auto Rental” receipt display 
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Auto Rental 

  

  

Auth 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select AUTH from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit  
6.)    If the card is not swiped key any cardholder details needed 

7.)    Click submit at the bottom for the screen 

8.)    Screen will prompt to please fill out additional auto rental info 

 

Figure 35 TransClient-“Auto Rental Info” receipt display 

Transaction 

Types 

Transaction Function 

Auth Holds funds on a credit card for a period of time. 
Force Charges the credit card the amount that was held in the Auth. 
Sale Places a charge on a credit card. 
Credit Returns funds from your account to the credit card. 
Void Voids out a Sale/Force transaction if the batch has not been closed. 
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9.)    Key the RentalAgrmntNbr, Pickup Time, Extra Charges, and Special Program 
Code if needed 

10.)  Click OK or press enter and the transaction will be processed 

  

Sale 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select SALE from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit  
6.)    If the card is not swiped key any cardholder details needed 

7.)    Click submit at the bottom of the screen 

8.)    Screen will prompt to please fill out additional auto rental info 

9.)    Key the RentalAgrmntNbr, Pickup Time, Extra Charges, and Special Program 
Code if needed 

10.)     Click OK or press enter and the transaction will be processed 

  
 
 
 

Credit 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select CREDIT from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 

8.)    Click submit at the bottom of the screen 

9.)    Screen will prompt to please fill out additional Auto Rental info 

10.)    Key the RentalAgrmntNbr, Pickup Time, Extra Charges, and Special Program 
Code if needed 

11.)    Click OK or press enter and the transaction will be processed 

  
Force 

  
1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select FORCE from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 
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•        If card is swiped the transaction will automatically submit 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 

8.)    Click submit at the bottom of the screen 

9.)    Screen will prompt to please fill out additional Auto Rental info 

10.)    Key the RentalAgrmntNbr, Pickup Time, Extra Charges, and Special Program 
Code if needed 

11.)     Click OK or press enter and the transaction will be processed 

  

Void 

1.)    Select “Transactions > VPOS” from the TransClient menu bar 
2.)    Select Credit Card as the payment type 

3.)    Select VOID from the trans type pull down tab 

4.)    Key the transaction amount under payment details 
5.)    Swipe card or key the card #, Expdate, and CVV2 under payment details 

•        If card is swiped the transaction will automatically submit 
6.)    Ticket # from the original transaction must be entered under payment details 
7.)    If the card is not swiped key any cardholder details needed 

8.)    Click submit at the bottom of the screen 

9.)    Screen will prompt to please fill out additional Auto Rental info 

10.)      Key the RentalAgrmntNbr, Pickup Time, Extra Charges, and Special Program 
Code if needed 

11.)     Click OK or press enter and the transaction will be processed 

  

Reports 

  

1.)    Select Transactions > Stats from the TransClient menu bar 
2.)    Select Transaction type to search for and any additional search parameters 

desired 

3.)    Select the search transactions button and any transactions matching the search 
criteria will be displayed  

  

Note: Users cannot view transactions ran by the admin and by default cannot view 
transactions ran by any other users.  For a user to be able to see other user’s transactions 
view other has to be checked under that user’s setup. 

  

Adding clerks to the desktop client 

  

This can only be done when logged in as Admin. 
1.)    Select Database > Users Setup from the TransClient menu bar 
2.)    Key in the user information and the ID 

3.)    Enter the users password and select the transaction types allowed 

4.)    Then click the add button and the user should now be displayed as a user under 
user setup  
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6.9 Stats 

6.9.1 Search for a Previous Transaction 

 
The “Stats” feature allows you to specify information about transactions and search the 
SLIM CD Server for matching records. 
 

1. Display the “TransClient” Menu. 
2. Select “Transactions.” 
3. Then click “Stats” from the pull-down selection to display the “Stats” screen 

window. 

 

Figure 36“TransClient” Menu “Stats” window view 

 
4. Use the pull-down menu to select a “Trans Type.”  

 

Note: Select “ALL” to search for any transaction made by any clerk, or select a specific user to 

set the user name of another clerk and to list just those transactions.  

Note: You can list transactions of any type, or just transactions of a specific type. 

 

5. Populate the “Search Parameters” section of the Stats menu display:  
 

4. Selection 

Choices:All, 

Auth, CheckVer, 

Credit, or Force 

The default date is preset for the 
current day’s transactions only.  

The system 
administrator 
logged in using 
the ADMIN User 
Name has a User 
name set to match 
transactions 
performed. 
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Heading Details for Entering Information  

Card #  The last or first 4 digits of the credit card #. 
Email Email Address 
Firstname Customer’s First name only 
Lastname Customer’s Last name only 
User Use pull-down menu to select choice. 
SID TICKET # # Displayed 
Amount The exact amount of the transaction 
Zip Customer’s Zip Code 
Invoice The Invoice Number assigned to the transaction. 
TICKET # Enter TICKET # #. 
Date Use the month, day, and year to enter a date range  

 
6. Select “Search Transactions.” 
7. Only The Transactions that match ALL criteria are then displayed. 
8. A letter code will stand for the details of the transaction records: 

 
Code Transaction Record Detail 

Y Approved Transaction 
N Declined Transaction 
D A Disallowed Transaction Due to Fraud Scrubbing 
E Indicates an Error in Processing the Transaction 

 

6.9.2 Sort Transactions  

 
9. Sort the displayed transactions by clicking on a Column Header (Ex.TransType). 
10. Double-click on any row to find out more details about a specific transaction. 

 
Note: Clerks can only display transactions performed by the user name that corresponds to their 

login User Name, and the user name field is disabled. 

 

Figure 37“Sort Transactions” screen view window. 

9. Double-
Click on any 
row to select 
the transaction. 
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6.9.3 Re-Print A Receipt 

 
11. The “Transactions details” receipt can now be viewed.  

 

Note: All information for this transaction is available, except the credit card number. The credit 

card number is not displayed for security reasons. 

 
 

 

Figure 38“Transaction details” screen window 

 
12. If you have previously selected a printer, you may print a duplicate copy of the 

receipt by clicking “Print Receipt.” 
13. Click “VPOS” to send information from this transaction into the VPOS screen to 

pre-fill personal information for repeat customers when performing a Force 
transaction on an Auth, or a Void/Credit on a Sale. 

 
Note:  If the ePad box is checked in the VPOS screen, the Transaction details screen also 

includes the signature line. 

 

 

Note: The 

TICKET # 

Note: Old 

signatures are not 

re-used when 

pressing the VPOS 

button.  

14.  A new signature 

must be captured for 

any additional 

repeat card swipe) 

to perform a SALE 

transaction. 
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14. Click the lower half of the screen that contains the signature to generate a blank 

line. 
15. Allow your customer to re-enter their signature.  

 

6.10 Database 

 
Note: The Database pull-down menu items allows only the ADMIN to export your transactions 

and to manage users.  

 
 

6.10.1 Select SQL Server 

 
Note: Enabled for the Enterprise Edition of SLIM CD which allows the selection of a different 

SQL server to store transactions. This selection is disabled on the regular version of the SLIM 

CD. 

6.10.2 Users Setup 

 
Note: The Add Users command allows you to grant access to clerks. Once a clerk has been given 

a User Name and Password, they can log in to the SLIM CD software and process transactions. 

All transactions are identified with the clerk’s User Name in the transaction records. 

 
1. Open the “TransClient” transaction menu. 
2. Select “Users Setup” from the “Database” pull-down menu. 
3. The “TransClient” window for setting up or modifying User information is 

displayed. 

 

Figure 39“TransClient” Database window for “Users Setup” 

9. Select 
“Users 
Setup” form 
Database 
menu. 
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6.10.2.1 Add A New Clerk 

 

1. Select “New” to add a new clerk to the database. 
2. The TransClient screen replaces “New” with the “Add” button and enables the 

fields: “User ID,” “Password,” “First Name,” and “Last Name.” 
3. Enter all of the New User information in each of the fields described in Step 2. 
 
4. Then click “Add.” The new Clerk is now a valid User. 
5. Select: AUTH, SALE, FORCE, CREDIT or VOID to grant permission to each 

clerk to perform specific transaction operations. For example, set up one clerk to 
accept payment for transactions, and another for credits/refunds 

6. Select “Close” when finished. 
 
Note: To add additional Users, simply repeat steps 1 through steps 4. 

 

 

Figure 40“Add User” Database screen window 

 

6.10.2.2 Modify Information 

 
1. View the “User Setup” display to locate the User information you wish to modify. 
2. Click to highlight the information displayed for that specific User. 
3. Click “Modify.” 
4. Enter the new information in the enabled fields you wish to change. 
5. Select “Update” to save this new information on the SLIM CD Database. 

 
Note: To change the ADMIN password, contact the Slim CD, Inc. 

Customer Support at 1(877) 475-4623. 

6.10.2.3 Delete a Clerk 

 

1. Select 
“New” to add a 
new clerk to 
the database. 

3. Enter all of the new 
User information in 
the fields below. 

4. Then 
click 

“Close.
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1. View the User Setup display to locate the displayed information from the User ID 
that needs modification. 

2. Click to highlight the User Information displayed for that specific Clerk or User. 
3. Click the “Delete” button (located above the field labeled: User ID).  
4. Click “Yes” to set this User as ‘INACTIVE.’  

 

 

Figure 41User Setup ‘INACTIVE” screen window 

 

6.10.3 Setup Hardware 

 
1. Select “Setup Hardware” from the “Database” pull-down menu to generate 

“Hardware Setup” screen display. 
2. Locate and click the mouse in the smaller window for the hardware accessory you 

wish to select.  
 

 

 

Figure 42“TransClient” Database “Hardware Setup” screen display 

 
 

Note: The 

‘INACTIVE’ 

User can no 

longer login 

to SLIM CD.   

 

Note: 

Selections 

Include: 

Pinpad, MICR 

Reader, 

Printer, Select 

Signature 

Pad). 
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6.10.3.1 Pinpad 

 
1. “Select Pinpad Type” by using the pull-down menu.  
2. Use the pull-down menu to select the COM “Port” to which the “Pinpad” is 

connected, the “Baud” number, and the “Parity.”  
 
Note: The Pinpad only supports transactions types of Sale and Credit. 

 

6.10.3.2 MICR Reader 

 
1. Select “MICR Type” using the pull-down menu. 
2. Select the COM “Port” to which the MICR Reader is connected. 
3. Use the pull-down menu to select the number of “Data bits” the Reader holds. 
4. Use the pull-down menu to select the “Baud,” “Parity,” and “Stop bits.”  
5. Click “Close” when you are finished. 

6.10.3.3 Printer 

 
1. A list of installed printers will be displayed on the top-right of the screen.  
2. Select your printer from the pull-down list. 

 

6.10.3.4 Signature Capture Devices 

 
1. Locate and select the three Signature-Pad choices: 

� none 
� Interlink Electronics ePad 
� Interlink Electronics ePad w/Clip 
� SigLite SL Topaz Systems, Inc. 
� SigLite SL w/Clip  Topaz Systems, Inc. 

 
Note: The SLIM CD supports both ePad configurations:  

� The ePad is a signature capture device that allows customers to 
electronically sign their receipts and eliminates the need to keep small 
signed paper receipts.  

� The regular ePad allows your customers to sign on an electronic tablet 
using a special pen instead of using a traditional pen and ink.  

� The ePad w/Clip is a hybrid, allowing your customers to sign with a pen, 
but also capture the signature electronically. 

 
2. Select the hardware you prefer and enable the corresponding ePad option.  
3. The SLIM CD alters the way it prints receipts based on these choices.  
4. When using the ePad, the SLIM CD prompts for the tablet to be signed, then the 

receipt is printed for the customer.  
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5. When using the ePad with clip, the receipt is printed first, so the customer signs in 
ink, and keeps the signed receipt. 

 

6.10.4 Export Transaction 

 
You can export transactions from The SLIM CD Server into an ASCII file from the 
Database pull-down menu. 
 

1. Select “Export Transactions” from the Database pull-down menu to display 
the “TransClient” Exporting screen window. 

 

 

Figure 43“TransClient” Exporting screen window 

 
2. Locate “File Path and Name.”  
3. Type in the File Name manually or use the Browse feature pull-down menu to 

select the file you wish to export. 
4. Locate “Select Date Range.” 
5. Use the pull-down menus to specify a “Start Date” and “End Date” for the 

transaction/s to be exported.  
6. Click to specify the separator character (comma, tab, semicolon) for each data 

field in the row.  
7. Click the check box or “Select All” or “Deselect All” to specify the individual 

fields to be exported, and how those fields should be delimited.  
 
Note: You must specify at least one field for the export file to contain any data. 

Note: The Select All button selects all fields to be exported.  

Note: The Deselect All button clears the checkbox for all fieldnames.  
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6.10.5 Merchant Login 

 
1. Display the “TransClient” Menu. 
2. Select the “Database” pull-down menu and click “Merchant Login.”  
3. The default web browser opens to the Slim CD Merchant Login page. 
4. Enter your “Client ID” and “Password.” 
5. Click “LOGIN.” 

 
Note: This menu choice is enabled only when the ADMINistrator is logged in to the SLIM CD 

software.  
 

 

Figure 44“Merchant Login” window 

 
1. The “Quick Stats” screen is displayed. 

 

Figure 45Merchant Login “Quick Stats” screen display 

4. Enter your 
“Client ID”     and 
“Password.” 

5. Click “Submit.” 
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Note: The SLIM CD User’s Guide contains information on all functions and features available as 

part of the merchant’s login to the SLIM CD back-end reporting system. 

 

6.10.6 Restore Database 

 
� The Restore Database feature allows users of the Enterprise Edition to 

restore their database from information stored on the SLIM CD server for 
your Client ID login.  

� It is disabled on the regular version of the SLIM CD and is only enabled 
for the enterprise edition of the software. 

 
 

6.11 View 

 
� The View pull-down menu items allow you to change the appearance of 

the SLIM CD display. 
� The View also allows you to launch into an external program to monitor 

the modem’s communications. 

6.11.1.1 RasMonitor 

 
� The RasMonitor menu item launches the RasMonitor program on 

Windows NT. Dial-up Networking must be installed to use the 
RasMonitor program.  

� If you do not use a modem to connect to the Internet, or you are not 
running Windows NT, you should not need to use the RasMonitor. 

6.11.1.2 Status Bar 

 
� The Status Bar menu item adds or removes the status bar from the bottom 

of the SLIM CD software’s display window. 

6.12 Help 

� The Help pull-down menu items allow you to access the SLIM CD 
software’s Help Text. 

� The Help Topics menu item launches the Windows Help system. 
� The Help Topics display the help text for the SLIM CD software.  
� You can also launch the Help System for any menu item by pressing F1 

while the menu item is highlighted. 

6.12.1 SlimCD Updates and Patches 
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The Check for Updates menu item launches your default browser to a site with 
information on the latest available version of the SLIM CD. 
 

 

Figure 46“SlimCD Updates and Patches” menu display 

 

6.12.2 About TransClient 

The “About TransClient” menu item displays the copyright and current version of the 
SLIM CD software. 
 

7 The Slim CD website 
The Slim CD website provides merchants with full control over credit card processing. 
The website offers a comprehensive and user-friendly online reporting system with a 
built-in Fraud Prevention System. The website allows the merchant to process 
transactions, configure merchant setup, fraud control, view online transaction reports and 
display transaction summaries from the interactive terminal and the associated reporting 
system. 
 

7.1 User Login 

 
1. Open your Internet Browser. 
2. Enter the following URL:   www.slimcd.com 
3. Enter your 4-digit client ID and password. 
4. Press the submit button 
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Figure 47  www.slimcd.com home screen 

 
 
 
 
 
 

5. Once the login is successful, your browser will default to the Quick Stats 
screen for your merchant account, which allows clients to view a sum of 
activities for the current day, from the previous day, and a total from the 
past 7 days. 

Enter 4-
digit 
client ID 
 
Enter 
password 
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Figure 48 Quick Stats Screen 

6. At the top of the screen, you have the option to chose from four different 
menus: Config, Fraud Control, Stats, and Vpos.  Once a menu is selected, 
its contents will display on the left side of the screen.  If the merchant has 
multiple sites configured for the account, there is a Site ID drop down box 
at the top of the screen so the merchant can have access to switch between 
the multiple sites on the account.  Immediately to the right of the Site ID 
drop down box is a feature which will log you out of the system when you 
are ready to close out your session on the slim CD website. 

 

7.2 Config Menu 

 
1. Once a user is logged into www.slimcd.com, from any screen they may 

select the Config menu from the top left corner of the screen, and the 
Config Menu options will display on the left side of the screen. 
Note:  Only merchants set up as Mail Order/ Direct Marketing or E-

Commerce business types will have access to the Shopping Cart and 

Generate Buy Button choices under the Config menu. 

 

Figure 49 The Config Menu 

Menu 
Options 

 

Site ID  
dropdown 
menu 
 

Logout  

Select  

Config 

Config 
menu 

options 
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7.2.1 Batch Close Time 

1. Select Batch Close Time under the Config Menu.   

 

Figure 50 Batch Close Time Screen 

2. From the drop down menu, please select the hour of the day you would 
like your transaction totals for the day (Batch) to be sent out to your 
merchant bank for back end processing.  If you prefer to not have your 
totals batch out at a set time, select the option close manually. 

3. Press Save Batch Close Settings when you have made your choice. 
 

7.2.2 Change Your Password 

1. Select Change your password under the Config menu. 
2. If you wish to change your Slim CD user password, enter your old 

password, the password you would now like the system to recognize, and 
then confirm your new password choice. 

3. Click on submit to complete this process, or press the clear fields button to 
start this process over. 

 

7.2.3 Close Batch 

1. Select Close Batch from the Config menu.  Note:  This option 

should only be selected for merchants who have their Batch 

Close Time set to Close Manually. 

Batch 
time 
drop 
down 

menu 
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Figure 51 Close Batch Screen 

2. A confirmation summarizing the batch details will appear after 
the batch is closed 

7.2.4 Merchant Settings 

1. If the merchant needs to have changes made to the contact 
information, processor information, or type of payment form 
accepted, then select Merchant Settings under the Config menu. 

 

Figure 52Merchant Account Company Info. Screen 

Press to close  
batch for the 

day 
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Figure 53Accepted Types of cards Screen 

Note:  A merchant must have their bank configure the merchant account so that the 

merchant can accept Amex, Discover, JCB, Diners, Debit, and EBT cards. 

 

 
 

Figure 54 Check Platform Information Screen 

Note:  The fields on this screen will vary depending on the type of check processing 

platform specified. 

 

 

Figure 55 Gift Card Platform Setup Screen 
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Figure 56 Credit Card Processing Platform 

Note:  The fields on this screen will vary depending on the type of credit card processing 

platform specified. 

 

 

Figure 57Pin Pad Debit and EBT Setup Screen 

2. Press the Submit Query button when the appropriate changes are 
made, or press the Reset field values button to default back to 
the original settings. 
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7.2.5 Generate Buy Buttons 

Note:  This option is only available for merchants that are setup as E-Commerce and 

Direct Marketing merchants.  Please refer to section 8.5 on how to operate this feature. 

 

Figure 58 Generate Buy Button Screen 

7.2.6 Shopping Cart 

Note:  This option is only available for merchants that are setup as E-Commerce and 

Direct Marketing merchants.  Please refer to section 8 on how to utilize the Shopping 

Cart. 

7.3 Fraud Control Menu 

1. Once a user is logged into www.slimcd.com, from any screen they may 
select the Fraud Control menu from the top left corner of the screen, and 
the Fraud Control Menu options will display on the left side of the screen. 

 
 

Figure 59 Fraud Control Menu 
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7.3.1 Block Card number 

Purpose:  To prevent the merchant from accepting a certain card number 

1. Enter the card number in the field  
2. Press the submit button 

 

7.3.2 Block IP Address 

Purpose: To prevent transactions from being accepted for a specific IP address. 
1. “Enter IP Address” in the designated field. 
2. Press the submit button 

 

7.3.3 Set Blocking Controls 

 

Figure 60  Block Control Settings 

1. Select “Use global Negative Card Database” to block any card number already 
previously blocked by a SlimCD user, or select the second option if you wish to 
only block card numbers keyed in under your Block Card Number option. 

2. Press the Update Settings button. 
 

7.3.4 View AVS Results 

Purpose: To view the Address Verification Service (AVS) results from CARD NOT PRESENT & 

CARD PRESENT transactions. 

 
1. Select “View AVS Results” from the “Fraud Control” menu. 
2. Select the date range by using the pull-down menus “From” and “To” a period 

less than or equal to three months. 
3. Select Card Present or Card Not Present from the drop down menu. 
4. Click “Submit” to generate a “View AVS Results Report.”   

 
Note: This report IS sensitive to the SiteID  setting, and only transactions that match the site 

specified in the SiteID pulldown menu will be used to generate the report. 
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Figure 61 View AVS results screen 

5. Click on any number in the report to produce a list of corresponding transactions. 
6. Select any item in the list to display information on the individual transactions. 
 

 

7.3.5 View Bin Hits 

PPuurrppooss ee ::   Selecting the View Bin Hits Menu Item allows you to see prefixes, transaction counts, 

and unique card number count for your transactions within the specified date range.   

 
1. Select “View BIN Hits” from the “Fraud Control” menu. 
2. Select the date range by using the pull-down menus “From” and “To” a period 

less than or equal to three months. 
3. Click “Submit” to generate a “View BIN Hits.”   
4. Select any item from the list will to display information on the individual 

transactions for that item. 

 
 

Figure 62Bin Hits Results 

 

7.3.6 View ClassC Hits 

 

PPuurrppooss ee ::   To view the first 10 characters of the IP addresses, transaction counts for 

those ip address prefixes, and counts of unique transactions from those ip address 

prefixes, within the specified date range.   
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1. Select “View ClassC Hits” from the “Fraud Control” menu. 
2. Select the date range by using the pull-down menus “From” and “To”. 
3. Click “Submit” to generate a “View ClassC Hits.”   

7.4 Stats Menu 

 
1. Once a user is logged into www.slimcd.com, from any screen they may select the 

Stats menu from the top left corner of the screen, and the Stats Menu options will 
display on the left side of the screen. 

 
 

Figure 63 Stats Menu 

7.4.1 Clerk Report 

1. Select “Clerk Report” from the “Stats” menu selection. 
2. Use the pull-down menus to select a date and time range to be included in the 

report. 
3. Click “Submit.” 
4. View the generated “Clerk Report,” display which includes the Clerk, Transaction 

Count, Total Sales, and Tips that occurred during the time period selected. 

 

Figure 64 Clerk Report Screen 
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7.4.2 Daily Summary  

 
Purpose: Displays a summary report of activity during a specified date range.   

 

1. Select “Daily Summary” from the “Stats” menu selection. 
2. Use the pull-down menus to select a date and time range to be included in the 

report. 
 
Note: The default values are set to the current day, month and year, to give you a report 

of the current day’s activity.   

Note: The date range cannot exceed a period of 18 months. 
 

3. Click the “Show Clients/Sites” to select this option. 
4. Click “Include Voided Transactions” to select this option. 
5. Click “Submit.” 

 

Figure 65 Daily Summary 

 
6. Click on any date to view the details of each transaction recorded on that date. 
 
 

 

Figure 66 Daily Summary Transaction Details 
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7. Press the export button at the top of the chart to convert the content into a 
Microsoft Excel spreadsheet. 

 

7.4.3 List Batches 

 
Purpose: Displays a list of the “Batches” that occurred during the period selected. 

 

1. Select “List Batches” from the “Stats” menu selection. 
2. Use the pull-down menus to select a date and time range to be included in the 

report. 
3. Then  click “Submit.” 
 

 

Figure 67 List of Batches 

4. Click on a batch ID or a batch date to view a batch itemization and summary for 
that date. 

 

Figure 68Batch Itemization and Summary Screen 

5. Click on a date to view the transaction details of each transaction. 
 
 

Press the 
export 
button to 
convert the 
batch report 
into an 
Excel 

spreadsheet 

Detailed 
view button 
 
Press this 
printer logo 
to print 
batch 
summary 
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7.4.4 Monthly Summary 

 
Purpose: Allows a Summary Report of any desired month’s activity to be displayed. 

 

1. Select “Monthly Summary” from the “Stats” menu selection. 
2. Use the pull-down menus to select a date to be included in the report. 
3. Then  click “Submit” 

 
Note: This display is NOT sensitive to the state of the SiteID pull-down, and the reports represent 

activity for your entire account. 

 

 
 

Figure 69Monthly Summary 

Monthly Summary  Section Details 

Raw transaction 
count 

Shows a count of the number of raw transactions attempted on your account.   
There are also counts of the approved and declined transactions.   
Your approval rate is shown as a percentage. 

Transaction type 
breakdown 

Shows the approved transactions by transaction type.   
There are counts and totals by transaction type.   
The transaction types represent the various transactions you have processed 
through the POS system. 
 

Monthly Totals Includes gross amount of transactions which result in deposits (charges, forces, 
etc), the amount of the transactions that result in deductions (credits, chargebacks, 
etc), and the difference as the net. 
 

Chargeback 
information 

Includes chargeback rate, as a percentage ration of chargebacks versus approved 
transactions for this period. 
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7.4.5 Open Auths 

 
Purpose:  To provide a list of Authorizations that have not been Forced through as of yet. 

 

1. Select “Open Auth” (Open Authorization) from the “Stats” menu selection. 
2. Use the pull-down menus to select a date and time range to be included in the 

report. 
3. Then  click “Submit.” 
4. Once the open Authorizations are displayed, click the clerk name link to reveal 

further details about the open Authorization. 

 

Figure 70Open Authorization Report 

7.4.6 Quick Stats 

(Refer to section 7.1 for details on the Quick Stats Menu) 

 

7.4.7 View Rawlogs 

Purpose: Allows you to search for specific transactions and transaction details with real-time 

generated “Rawlogs.” Rawlogs will show transactions attempts along with approvals and voids. 

 

1. Under the “Stats” menu, chose “View Rawlogs.” 
 

Note:  You will be prompted to choose either “rawlogs by date range” or “search 

rawlogs.”  The search rawlogs option incorporates a rawlogs by date range option. 

 
2. Click “Search Rawlogs” from the “View Rawlogs” selection menu. 
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Figure 71 Search Rawlogs Screen 

3. Use the pull-down menus to specify a date range. 
4. Click the boxes to select which “Display fields” to list on the report, and/or search 

for transactions by filling out the appropriate information in the “Search 
Parameters field.”  

5. Click “Submit” to generate a report confined to the parameters chosen. 
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Figure 72Rawlog Results 

 
 

7.4.8 View Transactions 

 
1. Click “View Transactions” from “Stats” menu selection.  A view transactions 

menu will appear on the left side of the screen.   

 

Figure 73 View Transactions Menu 

Note:  The “Search Transactions” option incorporates the “View by Date Range” option 

Click any of 
the links to 
search for 
transactions 
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Figure 74Search Transactions Page 

2. Use the pull-down menus to select a specific date range, type in specific “Search 
Parameters,” and click in the “Display fields” you wish to select. 

3. Press the submit button. 
 
Note:  .  The “View this week, View today, and View Yesterday” options each provide a 

transaction type summary followed by a list of transactions for that time period. 

 

Figure 75Last Seven Days Summary Screen 
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7.5 VPOS 

 
The VPOS (Virtual Point of Sale) allows merchants to enter and edit transactions. 
 
Note: The VPOS menu contains different menu options for each of the Merchant Types: Retail, 

Restaurant, Mail Order/Direct Marketing ,e-Commerce, Hotel, and Auto Rental. 

 

Note: Your assigned Client ID and Password automatically distinguish your registered 

Merchant Type. 

 
1. From the Merchant Login Screen window, click “Vpos.” 
2. The “Vpos” menu selections will be displayed (as pictured on the below Quick 

Stats screen). 

7.5.1 Retail Merchant; VPOS Selections 

 

 

Figure 76Vpos Screen for Retail Merchant 

7.5.1.1 Checkout  

Purpose: Easy way to charge a card by swiping a credit card or manually entering the card info.  
 
 

1. Select “Checkout” from the Vpos menu. 
2. The “Credit Card Acceptance” will open on your computer screen. 
3. Swipe the credit card or manually enter the card number in the first field under 

“Payment Details.” 
4. If you typed the # enter the Expiration Date printed on the front of the credit card 

by using the pull-down menus marked with arrows on the screen.  
5. Enter the transaction amount in USD (U.S. Dollars). 
6. Click “Submit.” 
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Figure 77Retail Credit Card Payment Screen 

77 ..   AA  ““TTrraannss aacc tt ii oonn   aapppp rroovveedd””   mmeess ss aaggee   wwii ll ll   bbee   dd ii sspp ll aa yyeedd   ii ff   tt hhee   cc rr eedd ii tt   

ccaa rrdd   ii ss   aapppprroovveedd ..   
 
NNoo tt ee ::   II ff   tt hhee   tt rr aannssaacc tt ii oo nn   ii ss   ddeecc ll ii nneedd ,,   aa   ccaa rrdd   ee rr rr oo rr // ddeecc ll ii nnee   mmee ss ssaaggee   wwii ll ll   bbee   

dd ii ss pp ll aayyeedd ..    

7.5.1.2 Return 

 
PPuurrppooss ee ::   Allows funds to be returned to the consumer’s credit card. (Issue a Refund) 

 

1. Select “Return” from the Vpos menu. 
2. The “ReturnRefund” form window will open on your computer screen. 
3. Enter the Ticket # from the original transaction/printed receipt. 

 
Note: The Ticket # can also be located by searching through the “Stats” menu selections. 

      
      Then, click “Lookup.” 
 
 

 

Figure 78Return/Refund Screen 

 
 

4. CConfirm the additional consumer information and original total amount for this 
transaction.   

5. Specify the amount to refund back to the cardholder. 
6. Click “Submit”. 
7. A “Transaction Approved or Declined” will be displayed.  

 
Note: Although the transaction occurs in real-time, VISA/MasterCard systems may not show the 

refunded transaction for 24 to 48 hours.  
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7.5.1.3 VPOS- Checks, Credit Cards, Gift Cards 

 
Purpose: Access to all Check, Credit Card, and Gift Card transaction types 
 

1. Select “Vpos” from the Vpos menu. 
2. The “Vpos Terminal” window will open on your computer screen. 
3. Enter the “Ticket #” for the transaction. – (Optional, looks up old data) 
4. Swipe the credit card. (only for Credit Card and Gift Card transactions). 
5. Enter the requested information under the “Card Holder Details” section of the 

form. 
6. Use the pull-down menu to select the “Transaction Type.” 
7. Enter the requested information under the “Payment Details” section of the form. 
8. Click “Submit” to confirm process the transaction. 
9. A “Confirm Transaction” screen will be displayed. 
10. Click “Submit” to approve/verify your selected transaction. 
11. A “Transaction approved” screen will soon be displayed. 
12. Select to “Duplicate Receipt” or begin a “New Transaction.” 

 

Figure 79Cardholder Details Screen 

 

 

Figure 80 Check Payment Details Screen 
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7.5.2 Restaurant Merchant; VPOS Selections 

 

Figure 81 Restaurant Merchant VPOS Menu 

Purpose: Enables a variety of credit card transactions, including authorizing a card, closing a 

ticket with a tip, and authorizing a credit card for a telephone order.   

 

Note: Online transactions may be performed by swiping the credit card or an offline transaction 

may be manually performed using an Authorization Code. 

7.5.2.1 Authorize Card 

Purpose: Allows a credit card to be authorized and funds to be held on the consumer’s credit 

card.  Performs an “Auth Only”, does not actually charge the card. 

  

1. Select “Authorize Card” from the Vpos menu. 
2. The “RReess tt aauu rraann tt   CC rr eedd ii tt   CCaa rrdd --AAuu tthhoorr ii zz aa tt ii oonn” form window will open on 

your computer screen. 
3. Swipe or manually enter the consumer’s credit card number. 
4. Enter the credit card Expiration Date.   

Note: You may also enter the Offline Authcode, if a credit card representative or customer service 

operator gave you a voice authorization.  

 

Figure 82Restaurant Credit Card Authorization Screen 

5. If the credit card is approved, a Transaction approved screen will be displayed.  
6. If the transaction is declined, a Transaction declined screen will be displayed. 
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7. Select to “Print Receipt” for the transaction or click “New Transaction” to begin a 
new credit card transaction. 

Note: The print dialog box for your printer should also appear automatically.  If the print dialog 

box does not appear, simply pull down the “File” menu of the receipt window and select “Print” 

(or, type the keystroke shortcut of “Ctrl-P”). 

 
Note: The transaction will be processed in real-time, but the charge will NOT appear on the 

consumer’s statement unless you Close the Ticket, or use the VPOS and perform a Force/Offline 

Force transaction. 

 

7.5.2.2 Close Ticket   

 
Purpose: Allows you to enter the tip amount and force the previously authorized charge to be 

placed on the consumer’s credit card.   
 

1. Select “Close Ticket” from the Vpos menu. 
2. The “RReess tt aauu rraann tt --   CClloo ssee   TTaabb” form window will open on your computer 

screen. 
3. Enter the Ticket #. 

 
Note: The Ticket # can be captured from the original transaction, or it can be found by searching 

using the Stats Menu. 

 
4. Click “Lookup.” 
 

 

Figure 83 Restaurant Close Tab Screen 

5. Confirm the additional consumer information and original total amount for this 
transaction on the displayed window.   

6. Enter the tip and the total amount to be forced. 
7. Click “Submit” to charge the displayed amount to the credit card.   

 

Note: The transaction will be processed in real-time, and the charge will appear on the 

consumer’s statement without further activity on your part. This must be done for the “Auth 

Only” transaction if you want to be paid. 

 

7.5.2.3 Phone-in Auth 

Purpose: Allows funds to be authorized on the consumer’s credit card, similar to the Authorize 

Card menu item.  It also allows personal information about the cardholder, such as their address, 

etc.  The address can be used to be entered to perform address verification. 

 

1. Select “Phone-in-Auth” from the Vpos menu. 
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2. The “RReess tt aauu rraann tt --   PPhhoonnee -- ii nn   CCrr eedd ii tt   CCaarrdd   AAuu tthhoorr ii zzaa tt ii oonn” form window 
will open on your computer screen. 

 

Figure 84 Phone-in Auth Screen 

3. Enter the consumer’s “Firstname,” “Lastname,” “Address,” “City,” “State,” 
“Zip,” “Country” and “Phone” number in the “Phone-in-Orders” section of the 
form. 

4. Enter  the “Cardnumber,” “Expdate,” and transaction “Amount” in the “Payment 
Details” section of the form. 

5. Enter the Offline Authcode, if a credit card representative or customer service 
operator gave you a voice authorization. 

6. Click “Submit.” 
7. The “Transaction approved” message will be displayed. 
8. If not approved, the “Transaction declined” message will be displayed. 

 
Note: This message contains the Ticket # and Approval Code. 

 

9.  Select to “Print Receipt” or begin a “New Transaction.” Receipts “pop-up” on 
approvals. 

 
Note: The transaction will be processed in real-time, and the charge will appear on the 

consumer’s statement without further activity on your part. 
 

Note: The print dialog box for your printer should also appear automatically.  If the print dialog 

box does not appear, simply pull down the “File” menu of the receipt window and select “Print” 

(or, type the keystroke shortcut of “Ctrl-P”). 
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7.5.2.4 VPOS- Checks, Credit Cards, and Gift Cards 

 

 

 

Figure 85  VPOS Restaurant Credit Card Screen 

 

Figure 86  VPOS Restaurant Checks Screen 
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PPuurrppooss ee ::   Allows any type of Restaurant transaction to be processed.    

  

1. Select “Vpos” from the Vpos menu. 
2. The “RReess tt aauu rraann tt --   VVppooss   TTeerrmmiinnaa ll” will open on your computer screen. 
3. Enter the Ticket # “From Past Approval.” (Optional) 
4. Swipe the credit card to populate the “Card Swipe Entry.” (Optional) 
5. Complete the “Cardholder Details” section of the form. 
6. Use the pull-down menu to select the “Transaction Type.” 
7. Complete the “Payment Details” section of the form. 
8. Then click “Submit.” 

 

7.5.3 Mail Order/ Direct Marketing Merchant; VPOS 

 

 

Figure 87  Mail Order/ Direct Marketing VPOS Menu 

1. Following the Merchant Login, select “Vpos” from the Vpos menu bar. 
2. The “QQuuii cckk   SS tt aa tt ss” menu selection bar will open on your computer screen. 
3. Click “Vpos” from the main menu bar. 

 
 

7.5.3.1 AuthOnly 

1. Click “AuthOnly” menu selection. 
2. Fill-in Card Holders info and click “Submit” 
      A “Transaction Approved or Declined” page will be displayed. 
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Figure 88 Direct Marketing Auth-Only and Charge Screen 

7.5.3.2 Charge 

1. Select “Charge” from the Vpos menu. 
2. The   ““CChhaa rrggee” window will open on your computer screen. 
3. EEnter the consumer’s credit card and personal information. (see above figure)  If 

the consumer is using a business card, enter that information at the bottom of the 
screen. 

4. Enter the Offline Authcode, if a credit card representative or customer service 
operator gave you a voice authorization.   

5. Click “Submit.” 
An Approval or Decline confirmation message will display on your computer screen. 
Note: The transaction will be processed in real-time, and the charge will appear on the 

consumer’s statement without further activity on your part. 

 

 

Figure 89Business Card Info. Screen 
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7.5.3.3 Direct Market -> Reversal 

    Purpose:  To reverse an authorization placed on a card 

 
1. Select “Direct Market” from the VPOS  menu. 
2. Select Reversal. 

 

Figure 90  Authorization Reversal Screen 

3. Enter the ticket number of the authorization. 
4. The details of the original authorization will display on the screen. 

 

Figure 91  Authorization Reversal Confirmation Screen 

5. Press the submit button. 
6. A transaction confirmation screen will appear. 

7.5.3.4 Force 

 
PPuurrppooss ee ::    Allows you to charge funds to the consumer’s credit card.   

 
1.  Select “Force” from the Vpos menu. 
2.  Enter the ticket number of the authorization. 
3. The details of the original authorization will display on the screen. 
4. Press the submit button. 
5. A transaction confirmation screen will appear. 
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Figure 92  Transaction approved screen 

7.5.3.5 Refund 

 
PPuurrppooss ee ::   AA ll ll oowwss funds to be returned to the consumer’s credit card.   

 

1. Select “Refund” from the Vpos menu selection. 

 

Figure 93  Refund Screen 

 
2. If you have the Ticket #, Enter the Ticket # and click “Lookup.” 
3. If there is “No Ticket #,” Click “Anonymous Credit” to proceed. 

 

Figure 94 Anonymous Credit Screen 

4. Fill-in Card Holders info and click “Submit” 
5. A “Transaction Approved or Declined” page will be displayed. 
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7.5.3.6 Repeat Customer 

 
Purpose:  For a merchant to add or edit the terms of an existing order. 

 

1. Select “Repeat Customer” from the Vpos menu. 
2. The Direct Marketing ““RReeppeeaa tt   CCuuss tt oommee rr” Ticket # entry window will open on 

your computer screen. 
3. Type in the Ticket # “From Past Approval.” 
4. Click “Lookup.” 
5. The transaction details are displayed 
6. Make the necessary changes and press submit. 

 

7.5.3.7 Void 

 
Purpose:  To void out an existing transaction 

 

1. Select “Void” from the Vpos menu.   
2. The Direct Marketing “Void Transaction” Ticket # entry window will open on 

your computer screen. 
3. Type in the Ticket # From past approval. 
4. The Direct Marketing “Void Transaction” details screen appears. 

 
 

Figure 95  Void Transaction Screen 

5. Press the Submit button. 
6. A confirmation screen will appear.   

 

7.5.3.8 VPOS – Gift Cards 

 
Purpose:  To sell, credit, void, activate, add to, replace, deactivate, or redeem points on a 

gift card 
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1. Select “VPOS – Gift Cards” from the VPOS menu. 
 
 
 

 
 

 
 

Figure 96  VPOS-Gift Card Screen 

 
2. Enter the ticket number of a previous transaction, or enter the card holder details 

along with the card number. 
3. Select the transaction type for the gift card being used, the expiration date on the 

gift card, and type in the amount to be used in the transaction. 
4. Press the submit button. 

7.5.4 E-Commerce; VPOS 

 

Figure 97   E-Commerce; VPOS Menu 

Insert ticket # 

Choose 

Transaction type  
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1. Following the Merchant Login, select “Vpos” from the Vpos menu bar. 
2.         The “QQuu ii cckk   SS tt aa tt ss” menu selection bar will open on your computer screen. 
3.         Click “Vpos” from the main menu bar. 
 

7.5.4.1 Authonly 

 
1. Select “Authonly” from the Vpos menu. 
2. The E-Commerce ““EE--CCoommmmeerr ccee   AAuu tthhoo rr ii zz aa tt ii oonn” window will open on your 

computer screen. 
3. Enter the “Cardholder Details” including the consumer’s credit card and personal 

information.   
4. Enter the “Payment Details” including the card number and expiration date. 
5. Enter the “Offline Authcode,” if a credit card representative or customer service 

operator gave you a voice authorization.   
6. Select a “Goods indicator” of “Physical” or “Digital.”  
7. Click “Submit.” 
 

 

Figure 98 E-Commerce Authonly and Charge Screen 

7.5.4.2         Charge 

 
PPuurrppooss ee ::    Allows you to charge funds to the consumer’s credit card.   

 
1. Select “Charge” from the Vpos menu. 
2. The E-Commerce ““CChhaa rrggee” window will open on your computer screen. 
3. EEnter the consumer’s credit card and personal information. If the consumer is 

using a business card, enter that information at the bottom of the screen. 
4.  (Note:  Consumers personal information must be entered for an E-Commerce 

transaction.)  
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5. Enter the Offline Authcode, if a credit card representative or customer service 
operator gave you a voice authorization.   

6. Click “Submit.” 
7. An Approval or Decline confirmation message will display on your computer screen. 
 

 

Figure 99 BusinessCard Info. Screen 

7.5.4.3 Force 

Purpose: Allows you to force the reserved funds from the AuthOnly transaction such that the 

charge will appear on the consumer’s statement.   

 
1. Select “Force” from the Vpos menu. 
2. The “E-Commerce Force” Ticket # entry window will open on your computer 

screen. 
3. Type in the Ticket # “From Past Approval.” 
4. Click “Lookup.” 

 
Note: The Ticket # can be captured from the original transaction, or it can be found by searching 

using the Stats Main Menu. 

  

5. Confirm the additional consumer information and original total amount for this 
transaction on the displayed window.   

6. Use the pull-down menus to enter the tip and the total amount to be forced. 
7. Click “Submit” to charge the displayed amount to the credit card.   
8.  

 

Figure 100  E-Commerce Force Screen 

7.5.4.4 Refund 

 
PPuurrppooss ee ::   AA ll ll oowwss funds to be returned to the consumer’s credit card.   

 

1.  Select “Refund” from the Vpos menu selection. 
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2. If you have the Ticket #, Enter the Ticket # and click “Lookup.” 
3. If there is “No Ticket #,” Click “Anonymous Credit” to proceed. 
4. Fill-in Card Holders info and click “Submit” 
5. A “Transaction Approved or Declined” page will be displayed. 
 

 

Figure 101 Anonymous Credit Refund Screen 

7.5.4.5 Repeat Customer 

 
Purpose:  For a merchant to add or edit the terms of an existing order. 

 

1. Select “Repeat Customer” from the Vpos menu. 
2. The E-Commerce ““RReeppeeaa tt   CCuuss tt oommeerr” Ticket # entry window will open on 

your computer screen. 
3. Type in the Ticket # “From Past Approval.” 
4. Click “Lookup.” 
5. The transaction details are displayed 
6. Make the necessary changes and press submit. 

 
 

7.5.4.6 Void 

 
Purpose: Allows a transaction to be cancelled before it appears or is added on to the consumer’s 

credit card billing statement.   

 
1. Select “Void” from the Vpos menu. 
2. The “E-Commerce Force” Ticket # entry window will open on your computer 

screen. 
3. Type in the Ticket # from “Original Card Transaction.”  
4. Click “Lookup.” 
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Note: The Ticket # can be captured from the original transaction, or it can be found by searching 

using the Stats Main Menu. 

 

5. Confirm the additional consumer information and amount to be “Voided” for this 
transaction on the displayed window.   

6.  Enter the total amount to be forced. 
7. Click “Submit” to charge the displayed amount to the credit card.   

Note: The “Void” transaction eliminates a transaction from occurring on your “Daily Merchant 

Batch.” 

 

Note: If the daily batch has already been closed, then you will get an error performing a Void 

transaction.  In this case, if you are Voiding a Charge or Force, then perform a credit 

transaction.  If you are Voiding a Refund and the batch has been closed, it is too late to void the 

refund. 

 

7.5.4.7 VPOS- Gift Cards 

 
Purpose:  To sell, credit, void, activate, add to, replace, deactivate, or redeem points on a 

gift card 

 
 

1.  Select “VPOS – Gift Cards” from the VPOS menu. 
2. Enter the ticket number of a previous transaction, or enter the card holder details 

along with the card number. 
3. Select the transaction type for the gift card being used, the expiration date on the 

gift card, and type in the amount to be used in the transaction. 
4. Press the submit button. 
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Figure 102  E-Commerce Gift Card VPOS Screen 

7.5.5 Hotel Merchant; VPOS Selections 

 

 

Figure 103  Hotel VPOS Menu 

Purpose: Allows a variety of credit card transactions, including pre-charging for a room 

reservation, authorizing a card at check-in, and charging the total amount at checkout to be 

performed.   

 
From the Merchant Login Screen window, the “Quick Stats” window will be 
displayed. Select “Vpos” from the Vpos menu.  The Hotel Merchant ““VVppooss” menu 
selections window will open on your computer screen. 

7.5.5.1 Check- In 

 
Purpose: Allows authorization for a credit card and hold funds on the consumer’s credit card.    

 
1. Select “Check-In” from the Vpos menu. 
2. The Hotel ““CChheecckk-- IInn” window will open on your computer screen. 
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Figure 104 Hotel Check-In Screen 

3. EEnter the consumer’s credit card and personal information. 
4. Enter the Folio Number and Room Rate for the customer. 
5. Enter the Check-In dates and Check-Out dates for the customer. 
6. Enter the Offline Authcode, if a credit card representative or customer service 

operator gave you a voice authorization.   
7. Click “Submit.” 
8. The “Transaction approved” message will be displayed. If not approved, the 

“Transaction declined” message will be displayed. 
9. Select to “Print Receipt” or begin a “New Transaction.” 

 

7.5.5.2 Check-Out 

 
PPuurrppooss ee ::   Allows the specification of additional charges and force the previously authorized 

charge to be placed on the consumer’s credit card.   

 

1. The “Hotel Check out” Ticket # entry window will open on your computer screen. 
2. Type in the Ticket # in the space provided. 
3. Click “Lookup.” 

 
 

Figure 105 Hotel Check-Out Auth Lookup Screen 

Note: The Ticket # can be captured from the original transaction, or it can be found by searching 

using the Stats Main Menu. 
 

4. Confirm the additional consumer information and amount to be “Charged” for the 
Check out transaction on the displayed window. 

Folio Number 
Room Rate 
CheckIn & 
CheckOut dates 

Stay Duration 
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5. Enter the total amount to be charged. 
6. Specify the extra charges and the total amount to be forced.  That total amount 

will be the amount actually charged to the card. 
7. Press the submit button 

 

Figure 106  Hotel Check-Out Payment Screen 

8. Select to “Print Receipt” or begin a “New Transaction” on the displayed “Receipt 
Screen.” 

 

7.5.5.3 Reservation 

 
Purpose: Allows funds to be charged to the consumer’s credit card to pre-pay for a room 

reservation. Additional information specific to the card holder may also be entered during this 

transaction including address verification.  

 
1. Select “Reservation” from the Vpos menu. 
2. The “HHoott ee ll --   RReessee rrvvaa tt ii oonn” form window will open on your computer screen. 
3. Swipe the credit card to populate the “Card Swipe Entry.” 
4. Complete the “Cardholder Details” section of the form. 
5. Use the pull-down menu to select the “Transaction Type.” 
6. Enter the Offline Authcode, if a credit card representative or customer service 

operator gave you a voice authorization.   
7. Complete the “Payment Details” section of the form. 
8. Complete the “Reservation” section of the form including  
9. Then click “Submit.” 

  
Note: The room rate, check-in date, stay duration and other hotel-specific information can be 

entered. 
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Figure 107  Reservation Screen 

 

7.5.5.4 VPOS-Checks, Credit Cards, Gift Cards 

 
Purpose: Access to all Check, Credit Card, and Gift Card transaction types 
 

1. Select “Vpos” from the Vpos menu. 
2. The “Vpos Terminal” window will open on your computer screen. 
3. Enter the “Ticket #” for the transaction. – (Optional, looks up old data) 
4. Swipe the credit card. (only for Credit Card and Gift Card transactions). 
5. Enter the requested information under the “Card Holder Details” section of the 

form. 
6. Use the pull-down menu to select the “Transaction Type.” 
7. Enter the requested information under the “Payment Details” section of the form. 
8. Enter the appropriate information under the “Charge Details” section of the form. 
9. Click “Submit” to confirm process the transaction. 
10. A “Confirm Transaction” screen will be displayed. 
11. Click “Submit” to approve/verify your selected transaction. 
12. A “Transaction approved” screen will soon be displayed. 
13. Select to “Duplicate Receipt” or begin a “New Transaction.” 
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Figure 108  Charge Details VPOS Screen 

 

7.5.6 Auto Rental Merchant; VPOS 

 

 

Figure 109 Auto Rental VPOS Menu 

7.5.6.1 Pickup 

 
1. Select “Pickup” from the Vpos menu selections. 
2. Swipe the customer’s credit card or manually enter the credit card information. 
3. Use the pull-down menu to select the “Transaction Type.” 
4. Enter the Offline Authcode, if a credit card representative or customer service 

operator gave you a voice authorization.   
5. Complete the “Charge Details” section of the form by choosing a rental date and 

rental duration. 
6. Once the information has been captured and is displayed on your computer 

screen, click “Submit.” 
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Figure 110 Auto Rental Charge Details Screen 

7.5.6.2 Drop-off 

 
Purpose: Allows any additional charges and force the previously authorized charge to be placed 

on the consumer’s credit card.   

 
1. Select “Dropoff” from the Vpos menu selections. 
2. The ticket lookup screen will be displayed.  Enter the ticket number of the 

Original Authorization transaction. 

 
 

Figure 111 Auto Rental Drop-off Screen 

3. Locate the Ticket # to verify that it matches the Ticket # entered. 
4. View the information displayed on the screen. 
5. Use the pull-down menus to change any incorrect information or changes to the 

rental fees. 
6. Click to check any “Extra Charges” section of the form if they apply to this 

customer. 
7. Select “Submit” to process this transaction. 
8. Select “Print Receipt” to print a customer receipt to your printer. 
9. Select “New Transaction” to perform a new transaction. 

 
 
 
 
 

Rental 
date & 

duration 
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7.5.6.3 VPOS- Checks, Credit Cards, Gift Cards 

 
Purpose: Access to all Check, Credit Card, and Gift Card transaction types 
 

14. Select “Vpos” from the Vpos menu. 
15. The “Vpos Terminal” window will open on your computer screen. 
16. Enter the “Ticket #” for the transaction. – (Optional, looks up old data) 
17. Swipe the credit card. (only for Credit Card and Gift Card transactions). 
18. Enter the requested information under the “Card Holder Details” section of the 

form. 
19. Use the pull-down menu to select the “Transaction Type.” 
20. Enter the requested information under the “Payment Details” section of the form. 
21. Enter the appropriate information under the “Charge Details” section of the form. 
22. Click “Submit” to confirm process the transaction. 
23. A “Confirm Transaction” screen will be displayed. 
24. Click “Submit” to approve/verify your selected transaction. 
25. A “Transaction approved” screen will soon be displayed. 
26. Select to “Duplicate Receipt” or begin a “New Transaction.” 
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Figure 112 Hotel VPOS Screen 
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8 The Shopping Cart 
 
The SLIM CD offers a unique approach to supporting the sale of merchandise on the 
Internet using a shopping cart.  
 

8.1 Premium Cart32 

 
Cart32, from McMurtrey/Whitaker & Associates, Inc., offers several options for the 
merchant to host the catalogue web pages on his/her own server. 

8.1.1 Existing Carts 

 
The SLIM CD, Inc. support staff provides software that allows the most popular 
shopping cart to integrate with the SLIM CD payment software system, or documentation 
to allow custom integration with other shopping carts or Internet systems. 

8.1.1.1 MIVA Support 

� Miva Merchant is the most popular shopping cart for Unix/Linux systems, 
and is also available for Windows.  

� The Slim CD support staff can provide a Miva Module that allows Miva to 
connect to the Slim CD gateway system. 

8.1.1.2 CART32 Support 

� Cart32 is the most popular shopping cart system for Windows.  
� For merchants that already host their shopping cart using CART32, the 

Slim CD support staff can provide a .CPP file that will connect to the 
SLIM CD gateway system. 

8.1.1.3 CUSTOM Support 

� The SLIM CD support staff can provide a technical integration document 
to those merchants who wish to develop their own shopping cart support.  

� Merchants can interface to the SLIM CD processing gateway system. 
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8.2 Configure SLIM CD Cart32 V.6.0 

 
1. Go to www.slimcd.com 
2. Click “Merchant Login” from the “Secure Link Merchant Services” window. 
3. Enter your Client ID and Password at the Merchant Login prompt. 
4. Select “Login.” 
5. The “Quick Stats” screen window is displayed. 
6. Click “Config” from the menu bar. 
7. Then click “Shopping Cart” from the “Config” menu list. 
8. Enter your password and select the “Edit SLIM CD Cart32 Configuration” button. 
9. If prompted re-enter your password and click “OK.”  

 

  

Figure 113“Cart32 Enter Client Password” window 

 
 
 
 
 
 

9. Enter password and 
click “OK.” 
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8.3 File 

 
Note: The File tab is automatically selected to display your “Company Info.” 

 

 

Figure 114“Cart32 Company Information” screen window 

 
Note: Use “File” menu bar to enter or utilize: “Company Information,” “Advanced,” “Change 

Client Password,” and “Export Client Data.”  
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8.4 Orders 

 

 

Figure 115Cart32 “Show Orders” selection window 

 
Merchants can use this feature to locate a previous order using different search 

functions. 
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8.5 Appearance 

 

 

Figure 116Cart32 “Appearance” selection window 

 

8.5.1 Buttons for Adding Items to the Cart 

� Select the Appearance 
� Select Buttons. 
� Then Add to Shopping Cart tab to display the options available for 

generating a button that can be placed on your web page.  
� Fill out the fields on the screens to automatically generate the HTML for 

your button. Creating HTML for Viewing the Shopping Cart 
� Select the View Shopping Cart tab to display the options available for 

generating HTML that can be placed on your web page.  
� Select the GET method to generate the HTML code for a clickable 

hyperlink, or select the POST method to generate the HTML code for a 
button. 
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8.5.2 Creating HTML for Emptying the Cart 

� Select the Empty Shopping Cart tab to display the options available for 
generating HTML that can be placed on your web page.  

� Select the GET method to generate the HTML code for a clickable 
hyperlink, or select the POST method to generate the HTML code for a 
button. 

 

8.6 Cart Settings 

 

 

Figure 117Cart32 “Cart Settings” selection window 
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8.7 Users 

 

Figure 118Cart32 “Users” selection window 

 

8.8 Reports 

 

Figure 119Cart32 “Reports” selection window 



SLIM CD, Inc.                              Phone: 1.877.475.4623                              Email: support@slimcd.com 

Desktop User Guide  2008                            Page 121 of 146                                             

www.slimcd.com 

 

 
 

8.9 Help 

 

 Figure 120Cart32 “Help” selection window 

 

8.10 The Shopping Cart  

 
Note: The integration from your catalogue to the shopping cart is performed using buttons on 

your catalogue’s web pages. These buttons must be written in HTML to conform to the 

requirements of the shopping cart software. 

 

Note: There are two ways to code the HTML. The first is to use the automatic form generation 

software, provided by the CART32 software development team, to produce HTML code snippets 

that you paste into your HTML pages. The second is to code the entire HTML yourself, using a 

standard HTML or text editor. 

 

Note: The tasks performed from your web site: 

� Adding Items To The Cart  

� Viewing The Shopping Cart  

� Emptying the Cart 
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8.11 Coding HTML Buttons 

 
Note: The shopping cart interface can involve more details than the forms wizard offers.  

If you require more specialized integration to the cart, you can code your own HTML buttons that 

use all of the options for the cart. 

 

Note: A detailed discussion of HTML programming techniques, and the options available as part 

of the CART32 software, are beyond the scope of this manual.  

To use advanced techniques (such as changing the price, weight, part number, and 
shipping expense of a product based on selection of the size), refer to the CART32 web 
site at: http://www.cart32.com/help.Back Office Interface for the Shopping Cart 
 
The SLIM CD shopping cart provides merchants with a back office operation center to 
help manage the shopping cart. This interface provides the ability to retrieve the details of 
individual orders made through the shopping cart. It can also be used to configure a 
variety of shopping cart options such as changing colors, shipping options, and other 
features of the shopping cart. 
 
Note: the back office is the reporting interface and is also referred to as the back end. It 
can be compared to standing behind the counter at a store, where only the storeowner and 
employees can see transactions and other shop details. 
 

8.11.1.1 SLIM CD Merchant Login Back-End User 

 
1. Log in at: http://www.slimcd.com/login.html 
2. The “Stats” page is displayed. 
3. Select “Config” from the Main Menu Bar to display the “Config” menu options. 

 

 

Figure 121“Stats” display at Merchant Login 

 

3. Select 

“Config.”  
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4. Click “Shopping Cart” from the “Config” menu bar to access the Back Office of 
the shopping cart. 

5. The “Back-Office Interface can now be viewed. 
 

 

Figure 122“Config” Shopping Cart 

 
1. Enter you Password and select “Edit SLIM CD Cart32 Configuration.” 

You will be prompted to “Enter Client Password.”  
2. Click “OK.” 

 

 

Figure 123“Enter Client Password” window 

Note: The Cart32 back office provides 

options that allow you to configure web page 

colors, shipping methods, and much more. 

 

Note: This 

“Password” should be 

7 characters:  A 6-

digit number, followed 

by a letter. 

 

2. “Enter Client 
Password.” 
3. Click “OK.” 
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3. The Cart32 “Web Admin” window “File” tab for “Company Information” is 

displayed. 
 

 

Figure 124Cart32 “Web Admin” screen window 

8.11.1.2 Show Orders 

 
1. Select “Show Orders” from the “General Tab” pull-down menu. 
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Figure 125Cart32 “Web Admin, Show Orders (Secure) drop-down window 

 
2. The “Show Orders Secure” Search screen is displayed. 
3. Use the pull-down menu to make a “Search By” selection: Order #, Email, Last 

Name, Status.  
4. Enter a date range or other search criteria to locate orders. 
5. Then click the “Search” button to “View” the order information. 

 

8.11.1.2.1 Set Up Fixed Shipping 

 
Note: The form wizards allow you to specify a price for shipping on a per-item basis. This is 

assumed to be INCLUDED in your total price. If you wish to have the shipping added into the 

price of your items, then you must set up a shipping method. 

8.11.1.2.2 Select Shipping Table 

 
1. Select the “Shipping Tab” from the “Choose Tab” pull-down menu.  
2. The Shipping window is displayed. 

 

Enter the 
date range or 
other search 
criteria. 
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Figure 126 Cart 32 "Shipping Tab" Window display 

 
3. Name a shipping type by entering, for example, “Shipping Included.”  
4. Click “Add Shipping Type” and “Shipping Included” are displayed in the list of 

Shipping Types. 
5. Then select “Edit” from the choice to the right of “Shipping Included.” 
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8.11.1.2.3 Make Edits 

 
1. The “Edits” window is displayed. 

 

 

 
       

Figure 127Cart32 "Edits" window display 

 
2. Select “Shipping Method.” 
3. Set the Shipping Method to “Built Into Item Cost.”  

 
Note: This method causes the cart to ADD the amount you specify in the shipping field to the 

amount of the item. Many other shipping options are available from this page including UPS and 

USPS. 
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8.11.1.3 Set up UPS Online Tools 

 
Note: The Cart32 back office interface also allows you to configure a direct connection to the 

UPS OnLine® choice for calculation of shipping costs based on the weight of products to be 

delivered. 

1. Select “UPS OnLine®” Tools from the Choose Tab.  
2. The “UPS OnLine® Tools” window is displayed. 

 

 

                      Figure 128 Cart32 “UPS OnLine®” display 

 
 

 

9 Support Center Information 
 

Let Us Help! 
*Online Help & Phone Support Services are always a complimentary.  

9.1 SLIM CD Support 

 

Contact us for all your SLIM CD support needs: 

 
Email: support@slimcd.com 

Telephone: 1-877-4-SLIM-CD 

 

9.2 Cart32 Support 

 
Contact the CART32 Support Staff to access free online help system at:  

 
http://www.cart32.com/help/ 

 
 

For Additional Help… 

 
� Using CART32 
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� Coding CART32 Buttons 
� Accessing Back-Office CART32 Features 
� Support options are available from the developers  
 
Call the CART32 support staff to purchase support by telephone at:  

 

Phone: 417.865 .1283 

http://www.cart32.com/support.asp 
Monday through Friday, from 9:00 am - 7:00 pm, Central Standard Time 

 

 
 
 

9.3 Frequently Asked (Q) Questions & (S) Solutions 

 
Q: What types of merchants does SLIM CD support? 

 

S: Retail, Restaurant, E-Commerce, Mail-Order/Phone-Order, Hotel, and Auto Rental. 

 

Q: How do I sign in and what is my USER NAME? 

 

S: User Names are created by the ADMIN. If you have not yet signed into the system, you 

can sign in using "ADMIN" as the USER NAME.  When you type ADMIN for the user 

name, a CLIENT ID box will appear.  You can then enter your client id and password to 

log into the SLIM CD desktop application. 

 

Q: How do I perform a CREDIT or REFUND? 

 

S: Enter the Ticket #  value from the original SALE transaction, on the original receipt.  

Another simple way to perform a REFUND or VOID is to use the "STATS" menu item to 

find the original transaction and the Ticket #.  

Search Transactions by date range.  (Search by name, card number, or other 

criteria).  Highlight the SALE transaction that you want to refund, and double-

click on that record.  A new box will appear that shows the details of this 

transaction. Click on the VPOS button to send all of this data (including the Ticket #) to 
the VPOS screen.  Change the transaction type from SALE to CREDIT, and press 

“SUBMIT.” 

 
Q: Does SLIM CD support PIN-based debit? 

 

 S: Yes, on all platforms except Nova and First Data’s Nashville Platform. 

 
Q: How are batches closed with the SLIM CD? 

 

S: SLIM CD automatically closes batches every 24 hours (midnight, Eastern Standard 

Time), or every 1000 transactions, whichever comes first.  Merchants need not ever close 

a batch again, just submit the transaction for processing and we take care of the rest. 
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Q: Does SLIM CD support recurring billing? 

 

 S: Yes, but only in the Enterprise Edition. 

 
Q: What is the Enterprise Edition? 

 

 S: The Enterprise Edition is a version of the SLIM CD that stores information on the 

merchant's computer, as well as on the SLIM CD servers.  The Enterprise Edition can be used to 

perform recurring billing or data mining.  It uses either SQL Server, or it installs and uses 

MSDE, which is Microsoft's Desktop Database Engine. 
 

 
Q: What is a TICKET #? 

S: The SLIM CD system generates a unique transaction identifier for all transactions in 

the system.  This identifier is called the TICKET #, or the GATEWAY ID. 

 
Q: What type of security does SLIM CD have? 

  
S:  SLIM CD has passed Visa's CISP (Cardholder Information Security Program) audit, 

and has been certified secure by SecurityMetrics (the security firm recommended by 

American Express).  SLIM CD encrypts cardholder data using SHA-1 and 3-DES 

encryption algorithms, and all data is sent using 128-bit SSL secure sockets. 
 
Q:  Does the SLIM CD work in a call-center environment? 

  
S: Yes, in fact the SLIM CD has specific features designed to help call centers work 

better!    Users can be given various permission levels. 

 

Q: Can individual users be set up using the SLIM CD, with individual permissions? 

  
S:  Yes.  Users can be given specific permissions to perform specific transaction types, 

and can be given permission to view just their own transactions or to view other clerk's 

transactions. 

 
Q:  Does the SLIM CD work in a networked environment? 

  
S: Yes, as long as the computers have Internet access.  The regular SLIM CD can process 

transactions or access data from any computer on the network, as long as the user has 

the necessary permissions. 

 

Q:  Does the SLIM CD have a Web-based Virtual terminal? 

  
S: Yes.  The virtual terminal for SLIM CD is customized for each industry type. You can 

find the Virtual Terminal in the Merchant Login section of our website.  Log in and click 

on the VPOS link at the top of our interface to see the Virtual Terminal choices on the left 

side of the screen. 

 

Q:  Does SLIM CD interface with QuickBooks, or other accounting packages? 
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S:  Not directly, but data can be exported from SLIM CD into an ASCII file.  From there, 

it can be imported into other software programs.  However, SLIM CD does NOT directly 

export data into QuickBooks. 

 

Q:  Does SLIM CD work with a mobile device? 

  
S:  SLIM CD can work on any computer that runs Microsoft Windows (such as a laptop) 

and that has Internet connectivity.  It DOES NOT work on palm or hand-held computers, 

although if they can connect to the Internet they can theoretically use the Virtual 

terminal. The Virtual terminal is NOT designed for use on small screens, so this may be 

somewhat impractical, but is theoretically possible. 

 
 
Q:  What types of reports does SLIM CD have? 

  
S:  SLIM CD provides a number of interactive web-based reports, including daily 

summaries and breakdowns by card type.  Individual transaction details can also be 

listed.  The SLIM CD reports make it easier to reconcile bank account deposits with 

merchant batch totals. 

 
Q:  Does SLIM CD perform inventory control? 

  
S:  No, SLIM CD is a replacement for POS equipment, not for an inventory system or 

cash register. 

 
Q: Does SLIM CD have to be used with an Internet gateway? 

  
S:  No, SLIM CD is its own gateway.  But, SLIM CD can be used with a select number of 

popular Internet Gateways.  SLIM CD can also be used as a gateway, if desired. 

 
Q: Does SLIM CD have to be used with an Internet gateway? 

  
S:  No, SLIM CD is it's own gateway.  But, SLIM CD can be used with a select number of 

popular Internet Gateways.  SLIM CD can also be used as a gateway, if desired. 

 
Q:  Can SLIM CD easily perform additional transactions for a repeat customer? 

  
S:  Yes, SLIM CD’s web-based interface has the ability to process a new transaction for 

an existing customer. Simply look up the customer with the Search Rawlogs feature and 

click the “Create A New Transaction” button. 

 
Q: What is the difference between RawLogs and Transactions? 

 
S: The “RawLogs” contain a record of all attempted transactions, including both 

approved and declined transactions.  The “Transactions” reports only contain approved 

transactions that are “financially significant” in that they hold funds from your 

customer’s credit card, transfer funds from your customer’s credit card or return funds to 

your customer’s credit card. 

 

Q: How do I close batches? 
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S: The SLIM CD system closes batches for you, automatically. Batches are closed every 

1000 transactions or every 24 hours, whichever comes first. You CAN close a batch 

manually if you wish.  Go to www.slimcd.com and select the “Merchant Login” button 

(or, pick it from the “Database” menu in the TransClient application).  This is the SLIM 

CD web-based back end reporting system.  The Close Batch command can be found 

under the “Config” menu selection. 

 

Q: How can I reconcile my bank account deposits? 

 
S: Your bank or merchant account provider may have tools to help you, but SLIM CD 

does provide features which can be useful.  Go to www.slimcd.com and select the 

“Merchant Login” button (or, pick it from the “Database” menu in the TransClient 

application).  This is the SLIM CD web-based back end reporting system.  From here, 

you can select two separate reports that can be very helpful in reconciling your bank’s 

deposit information. 

 

The “Daily Summary” report breaks down the transaction totals day by day (based on 

Eastern Standard Time).  You can see your gross and net transaction activity, as well as 

breakdowns by card type (Visa, Mastercard, American Express, Discover, etc).  This can 

be helpful to identify the individual card association amounts deposited into your 

account. 

 

The “List Batches” report presents information totals for individual batches (either 

manually or automatically closed groups of transactions).  These transactional totals will 

exactly match what the credit card companies see in their batch totals when you call their 

help desk.  Note that if you only process Visa and Mastercard, this may also match the 

bank deposits in your checking account. 

 

10 Appendix  
 

10.1 Publication, Copyright, & Trademark Information  

 
• No part of this publication may be reproduced or transmitted in any form or by any means 

without the written permission of Slim CD, Inc. 
• Slim CD, Inc. is not affiliated or associated with the following companies or their 

distributors: Microsoft Corporation/Netscape Communications 
• Windows, Windows 95, Windows NT , Windows 2000®, Windows XP® operating 

systems, and Microsoft Internet Explorer are registered trademarks of the Microsoft 
Corporation, and not of Slim CD, Inc. 

• MSDE®, and SQL Server® are registered trademarks of Microsoft Corporation, and not 
of Slim CD, Inc. 

• Netscape Navigator is a registered trademark of Netscape Communications Corporation, 
and not of Slim CD, Inc. 
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10.2 Data Fields for Merchant Setup Sheets 

 
Note: Required for SLIM CD Setup. 

 
 
Credit Card Merchant Information Details 

(1) Merchant Account # MID   

(2) Terminal ID # TID/V-number 

(3) Store Number    

(4) Terminal Number  

(5) Location Code    

(6) SIC Code MCC   

 
 
(7) Sub-Market Identifier Details 

(8) Time Zone Difference  
(9) Terminal Type Type of POS 

Device 
 
 
Bank Information Details 

(10) BIN Number    

(11) Agent Bank #    

(12) Agent Chain #    

 
 

Connection Information Details 

(13) Processor Client number    

(14) Processor Username    

(15) Processor Password   

(16) Processor Key  

 
 
Pin-Based Debit Card Merchant 
Information 

Details 

(A) Debit MID  

(B) Merchant ABA Number    

(C) Merchant Settlement Agent  

(D) Reimbursement Attribute  

(E) Sharing Groups  
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10.3 Processor Requirements 

 
 

Vital Processing Credit Cards:  
1,2,3,4,5,6,8,10, 11, 12 

Vital Processing Pin-based Debit:  B, C, D, E 

Heartland Exchange Credit Cards: 1,2,4,6,8 

Heartland Exchange Pin-based Debit: B,D 
 

Fifth Third/St. Pete Credit Cards: 1,4,5,6,8 

Fifth Third/St. Pete Pin-based Debit: B,C,D,E 
 

Global Payments Credit Cards: 1,6,7,9,10 

PaymenTech Credit Cards: 1,4,13,14,15 

First Data / Nashville Credit Cards: 1,2  
*Debit not supported by host 
for FRAME/IP connectivity 
 

First Data(Concord EFS)Memphis Credit Cards: 1 

First Data(Concord EFS) Pin-based Debit: A 

Nova Information Systems Credit Cards: 1,2,10  
* Pin-based Debit not 
supported by Nova’s Internet 
connectivity. 

AUTHORIZE.NET Credit Cards: 14,16  
*Pin-based Debit not 
supported by this Internet 
gateway. 
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10.4 SLIM CD Error Codes from the Gateway: 

Code:  One-letter identifier, where “E” is an input error and “N” is a decline. 
Message:  The message returned 
Explanation:  A simple explanation of the error. 
 

Code Message Explanation 

E *This application is currently unavailable. Please contact the 
systems administrator if you have any questions. 

The Slim CD system is down. 

E *clientid-priceid-siteid-missing You must supply a clientid, siteid, 
and priceid for each transaction 

E *INVALID_ACCOUNT_DATA_SENT The supplied clientid or password 
information is not accurate. 

E *INVALID_ACCOUNT_DATA_SENT The clientid, siteid and priceid 
combination is not accurate or 
acceptable 

E *INVALID_SITEID_OR_PRICEID The siteid or priceid is not 
assigned to this clientid. 

E *BS_ERROR The string “visa” or “Mastercard” 
appears as the first or last name 

E *INVALID_GATEID_SENT The gatewayid is not valid 
E *--INVALID_GATEID The gatewayid is not valid (no 

such record in our database) 
E *--GATEID_NEEDED Gateway id needed to perform a 

FORCE, CREDIT, VOID, FORCE, 
OFFLINEFORCE, 
INCREMENTAL, or REVERSAL 

E ERR-Insufficient_data The signature data does not have 
a corresponding clientid, siteid, 
priceid, gateway id, or the 
signature data is empty. 

E ERR-cant_insert_signature Error inserting the signature into 
the database 

E ERR-bad_permissions_or_no_gateid Could not find the gateid 
transaction for this signature. 

E *--ONLY_FORCE_AN_APPROVED_ 
TRANSACTION. 

The gateid does not represent an 
approved transaction. 

E *--ONLY_VOID_AN_APPROVED_ 
TRANSACTION. 

The gateid does not represent an 
approved transaction. 

E *--ONLY_CREDIT_AN_APPROVED_ 
TRANSACTION. 

The gateid does not represent an 
approved transaction. 

E *ONLY_OFFLINEFORCE_AN_APPROVED_TRANSACTION. The gateid does not represent an 
approved transaction. 

E *ONLY_INCREMENTAL_AN_APPROVED_TRANSACTION. The gateid does not represent an 
approved transaction. 

E *ONLY_REVERSAL_AN_APPROVED_ 
TRANSACTION. 

The gateid does not represent an 
approved transaction. 

E *AMOUNT_MISMATCH. Can only void a transaction for the 
exact amount of the original 
transaction 
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-OR-  
Can only FORCE a transaction for 
the exact amount of the original 
transaction, UNLESS the business 
type is Restaurat, Hotel, or 
AutoRental 

E *REFUND_AMOUNT_CANNOT_EXCEED_PURCHASE_AM
OUNT. 

The amount of the refund must not 
exceed the amount of the original 
purchase. 

E *ONLY_FORCE_AN_AUTH. The gateid provided does not 
identify an “AUTH” transaction. 

E *ONLY_OFFLINEFORCE_AN_ 
OFFLINEAUTH. 

The gateid provided does not 
identify an “OFFLINEAUTH” 
transaction. 

E *CANNOT_VOID_AN_AUTH The gateid  identifies an AUTH 
transaction.  This transaction type 
cannot be VOIDed. 

E *CANNOT_VOID_AN_OFFLINEAUTH The gateid  identifies an 
OFFLINEAUTH transaction This 
transaction type cannot be 
VOIDed. 

E *CANNOT_VOID_AN_INCREMENTAL The gateid  identifies an 
INCREMENTAL transaction This 
transaction type cannot be 
VOIDed. 

E *CANNOT_VOID_AN_REVERSAL The gateid  identifies a 
REVERSAL transaction This 
transaction type cannot be 
VOIDed. 

E *CANNOT_VOID_AN_VOID The gateid  identifies a VOID 
transaction This transaction type 
cannot be VOIDed. 

E *CANNOT_VOID_AN_AUTH The gateid  identifies an AUTH 
transaction This transaction type 
cannot be VOIDed. 

E *ONLY_CREDIT_A_SALE_OR_FORCE_OR_OFFLINE_OR_
OFFLINEFORCE. 

The gateid does not identify a 
SALE, FORCE, OFFLINE, or 
OFFLINEFORCE transaction 

E *MOD10_FAILED_OR_CARDEXPIRED The card number was entered 
incorrectly, or the card’s expiration 
date has been exceeded. 

E *Need the name of the state, or at least 2 characters for the 
state abbreviation. 

The value of “state” is 
unacceptable 

E *Unknown state: The value of “state” is 
unacceptable 

E *Need the name of the state, or at least 2 characters for the 
state abbreviation. 

The state name or abbreviation 
was not recognized. 

E *Invalid phone number beginning with +. Unwanted Country 
code. 

The phone number is 
unacceptable. 

E *Invalid characters in phone number. The phone number is 
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unacceptable. 
E *Invalid phone number beginning with 0. Unwanted Country 

code or 011. 
The phone number is 
unacceptable. 

   
E (1)Database Error - SQL Execution Error Database connection issue. Retry 

in a day. 
E (6)Communication Error - Unexpected Out-of-Sequenc Database connection issue. Retry 

in a day. 
E (8)Communication Error - I/O Error Connection rese VITAL ISSUE. Retry later. 
E (8)Communication Error - I/O Error null VITAL ISSUE. Retry later. 
E BAD MICR SWIPE. RE-ENTER Bad MICR data sent to processor. 

Examine your MICR swipe. 
E Invalid State Code Check your statecode. 
E No database connection available. Connection Error Network issue. Retry later. 
E R*(3)Communication Error - I/O Error :Connection r Network issue. Retry later. 
E RESEND WITH DLNO / DOB           The system wants more 

information. Supply an ID# and 
date of birth. 

E timeout / cannot connect to servlet    Network issue. Retry later. 
E (3)Communication Error - I/O Error :Connection tim Network issue. Retry later. 
E (3)Communication Error - I/O Error :java.security. Network issue. Retry later. 
E No database connection available. Connection Error Network issue. Retry later. 
E Need Driver License Number   Resend with driverlicense 
E Need MICR Data Resend with valid MICR data 
E Need State Code Resend with valid crosscheck 

statecode 
E timeout / cannot connect to servlet Network issue. Retry later 
E COMMUNICATION ERROR: System.Net.WebException: Network issue. Retry later 
E GENERAL TRANSACTION ERROR Do Not Retry 
E Host connection closed prematurely before receivi Network issue. Retry later 
E INVALID REFERENCE NUMBER check your data 
E NO STATION RECORD EXISTS bad merchant profile 
E REFERENCE NUMBER/AMOUNT MISMATCH  
E * decline 
E **8*;salestax:0.00;salestaxtype:1;encryptedpin:;or web server not responding 
E **Card must be presen;gatetransid:2008363;orderno card must be present 
E **con_To_InterLive_Er;gatetransid:1774394;orderno: web server not responding 
E **Merchant_0653386_no;gatetransid:1614812;orderno: merchant not borded properly 
E **SUMID_QUERY_3Time;gatetransid:1614735;orderno:1 web server not responding 
E *__;gatetransid:2127441;orderno:EUK0900;installmen web server not responding 
E *200509061538 web server not responding 
E *3Invalid_frm_InterLive web server not responding 
E *Already_Forced do not attempt any further action 
E *Already_Voided do not attempt any further action 
E *Card must be present for retail need to have card present 
E *Card must present need to have card present 
E *con_To_InterLive_Err= 10061 Invalid Data send from FDM 
E *FDMS_GateInsert.Open() fail Invalid Data send from FDM 
E *Invalid authcode: 8464711 Preauthorization code entered 
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wrong 
E *Invalid_amt:0 check the amount being charged 
E *Invalid_zip change the zip code entered 
E *InvalidRespDataLen Invalid Data send from FDM 
E *Merchant_0162362_not_found Try again, renter the transaction 
E *Not_Settled The type of transaction submitted 

must have prior settlement 
E *NoOpenClientToFDMS Try again, renter the transaction 
E *NotMOTECO428805 the type of transaction submitted 

must be MOTO/E-COM 
E *recv_FRM_IntLive_Err= 10054 reset connection 
E *recv_FRM_IntLive_Err= 10060 timeout error, reset connection 
E *RetryToFDMS retry transaction 
E *Settled_CREDIT_it use credit instead of void 
E *SUMID_QUERY_3Times need to obtain batch # prior to 

transaction 
E *WriteCommClient_fail Try again, renter the transaction 
E FDSTDLL web server not responding 
E FileErR file error 
E FileErU file error 
E InvAm      invalid amount 
E InvMIDIM invalid merchant ID 
E InvMTIR invalid merchant ID 
E InvMTIRX invalid merchant ID 
E invTIDR Invalid terminal ID 
E invTIDU     Invalid terminal ID 
E SysErrRX web server not responding 
E TinactRX web server not responding 
E TinactU web server not responding 
E (4)Communication Error : I/O Error Connection refu Network issue. Retry later 
E (3)Communication Error - I/O Error :Read timed out Network issue. Retry later 
E Invalid Approval Code check authorization code 
E No database connection available. Connection Error Network issue. Retry later 
E Original Transaction is NOT a SALE. Check VitalGat check your original ticket # 
E Transaction has been FORCED do not attempt any further action 
E Transaction has been settled. Use CREDIT use credit instead of void 
E (1)Database Error - SQL Execution Error String or Network issue. Retry later 
E (3)Communication Error - I/O Error :java.security Network issue. Retry later 
E (8)Communication Error - I/O Error null Network issue. Retry later 
E Auth Transaction has been forced. Use Force Transa Use Force 
E Can NOT VOID this Transaction. Check Gateway Recor transaction has been settled 
E No database connection available. Connection Error Network issue. Retry later 
E Tip Edit only allowed on FORCE or SALE. Check HLGa check your data 
E Transaction has been settled. Use CREDIT use credit instead of void 
E Error:-2147012744:The server returned an invalid o Network issue. Retry later 
E Error:-2147012894:The operation timed out Network issue. Retry later 
E IO Exception in Open Socket-Connection refused: co Network issue. Retry later 
E No database connection available. Connection Error Network issue. Retry later 
E BAD-MID-TID-USERNAME Fix your merchant profile and try 
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again 
E Cant connect to PAYMENTECH - retry in 15 seconds Network issue. Retry later 
E CONN_ERR_TO_PMT Network issue. Retry later 
E CONN_ERROR Network issue. Retry later 
E Error communicating to the host Retry later 
E initfail-Cannot access merchant index: 10 () Servlet is exclusive locked for that 

merchant. Retry later 
E initfail-Cannot access merchant index: 10 (Batchin Merchant is batching. Retry later 
E initfail-Cannot perform a reversal authorization o Do Not Retry 
E initfail-Cannot VOID a settled transaction use credit instead of void 
E initfail-Cannot void this transaction type use credit instead of void 
E initfail-Only approved transactions can be updated do not attempt to modify a 

declined transaction 
E initfail-This transaction has already been voided Do Not Retry 
E initfail-Transaction has been voided Do Not Retry 
E NETCONNECT-ERR General error. Retry later 
E The request contained an invalid password: [028100 CHECK your merchant profile 

setup 
E The request contained an invalid password: [P:0281 CHECK your merchant profile 

setup 
E ValdateMID: MID In Mime [02810004258] Doesn't Mat merchant profile error 
E ValdateMID: MID In Mime [43122022188] Doesn't Mat CHECK your merchant profile 

setup 
E Auth Transaction has been forced. Use Force Transa operate on the force, not the auth 
E Error:-2147012744:The server returned an invalid o Network issue. Retry later 
E Tip Edit only supported for Restaurant: 2 only use tipedit for restaurant 
E Transaction can NOT be FORCED. Check RBSGate Recor transaction has already been 

forced or is not forceable 
E Transaction has been FORCED do not attempt any further action 
E (10)Database Error - SQL Execution Error Transacti contact systems administrator 
E (3)Communication Error - I/O Error :Connection ref Network issue. Retry later 
E (3)Communication Error - I/O Error :Connection res Network issue. Retry later 
E (3)Communication Error - I/O Error :Connection tim Network issue. Retry later 
E (3)Communication Error - I/O Error :java.security Network issue. Retry later 
E (3)Communication Error - I/O Error :No buffer spac Network issue. Retry later 
E (3)Communication Error - I/O Error :Remote host cl Network issue. Retry later 
E (5.1)Communication Error - No Transmission from Vi Network issue. Retry later 
E (6)Communication Error - Unexpected Out-of-Sequenc Network issue. Retry later 
E (8)Communication Error - I/O Error Connection rese Network issue. Retry later. 
E (8)Communication Error - I/O Error null Network issue. Retry later 
E (8)Communication Error - I/O Error Read timed out Network issue. Retry later 
E Bad Stay Duration Value make sure stay duration is numeric 
E Can NOT VOID this Transaction. Check Gateway Recor transaction has already been 

settled 
E Cannot_create_xmlhttp:13:Type mismatch Retry later 
E Error:-2147012744:The server returned an invalid o Retry later 
E Error:-2147012867:A connection with the server cou Retry later 
E Error:-2147012894:The operation timed out Retry later 
E Inconsistent Busisness Type in client data Check merchant profile on 
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SLIMCD, make sure you have the 
right businesstype 

E Increment/Reversal is only supported by VISA only use incremental reversal with 
a visa 

E Incremental is only supported for Hotel only use incremental with a hotel 
merchant account 

E Installment Sequence Number can NOT be greater tha check your specification 
E Invalid Auth Transaction Code make sure auth transaction code is 

not all zeros 
E Invalid CVV2 Data:11o2/o. Only alpha-numeric allow make sure there are no invalid 

characters in cvv2 data field 
E Invalid PIN data length contact slimCD hardware support 
E Invalid Retrieval Reference No contact slimCD hardware support 
E Missing PIN data contact slimCD hardware support 
E Need Local Transaction Date contact developer support 
E No database connection available. Connection Error Network issue. Retry later 
E No offline CREDIT/FORCE/VOID allowed for Original contact developer support 
E Transaction already SETTLED/FORCED. Please use SAL please use sale 
E Transaction can NOT be FORCED. Check VitalGate Rec transaction has already been 

forced or is not forceable 
E Transaction has been FORCED Do Not Retry 
E Transaction has been settled. Use CREDIT use credit instead of void 
E Transaction is not SALE/OFFLINE. Can not be CREDIT you cannot credit this transaction 
E Unmatched Merchant ID:0 contact slimCD support 
E Unrecognized Response from Processor contact slimCD support 
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Certain data input errors will be presented as a SINGLE MESSAGE containing multiple errors.  
Those messages can include the following sub-strings: 
 

Code Message portion Explanation 

E --ERROR READING CARD - RESCAN. 
 

The track data from scanning the card 
contains errors. Please re-scan the 
card. 

E --NEED_FIRSTNAME. The first name was not provided. 
E --INVALID_FIRSTNAME. The first name contains unacceptable 

text. 
E --NEED_LASTNAME The last name was not provided. 
E --INVALID_LASTNAME The last name contains unacceptable 

text. 
E --FIRSTNAME_MATCHES_LASTNAME The first name and last name cannot 

be the same. 
E --NEED_STREET The street address was not provided 
E --INVALID_STREET. The street is invalid (does not contain 

reasonable street information) 
E --NEED_CITY The city was not provided 
E --NEED_STATE The state was not provided 
E --NEED_ZIP The zip code / postal code was not 

provided 
E --NEED_COUNTRY The country was not provided. 
E --UNKNOWN_NOT_ACCEPTABLE The country cannot be set to 

“Unknown”. 
E --UNKNOWN_NOT_ACCEPTABLE The country cannot be set to “Select”. 
E --NEED_PHONE The telephone number was not 

provided 
E --MISSING_CARD The cardnumber was not provided. 
E --NEED_EXPMONTH The expiration month for the card was 

not provided. 
E --NEED_EXPYEAR The expiration year for the card was 

not provided. 
E --AMT_MISSING There was no amount specified 
E --CLIENTID_MISSING The clientid value was not provided. 

(internal error) 
E --TRANSTYPE_MISSING There was no transaction type 

specified. 
E --AUTHCODE_NEEDED OFFLINE or OFFLINEAUTH 

transactions require an AUTHCODE 
E --NEED_EMAIL Email address is required, but not 

supplied 
E --INVALID_EMAIL 

 
Inaccurate email address information. 

E --INVALID_EMAIL:No @ sign detected. An @ sign is part of every e-
mail address. 

Inaccurate email address information. 

E --INVALID_EMAIL:An @ sign cannot be the last character of the e-
mail address. 

Inaccurate email address information. 

E --INVALID_EMAIL:An @ sign cannot be the first character of the e-
mail address. 

Inaccurate email address information. 

E --INVALID_EMAIL:A valid e-mail address contains only one @ sign. Inaccurate email address information. 

E --INVALID_EMAIL:No period detected. An e-mail 
address contains at least one period. 

Inaccurate email address 
information. 

E --INVALID_EMAIL:The last character of the e-mail address cannot Inaccurate email address information. 
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be a period. 

E --INVALID_EMAIL:The first character of the e-mail address cannot 
be a period. 

Inaccurate email address information. 

E --INVALID_EMAIL:A valid e-mail address cannot contain a comma. 
If you have a Compuserve account, substitute a period for the 
comma in your Compuserve ID, like so: 
12345.6789@compuserve.com. 

Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have a space as part of a single e-
mail address. 

Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have an asterisk in an e-mail 
address. 

Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have a close parenthesis sign in an 
e-mail address. 

Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have an open parenthes= sign in an 
e-mail address. 

Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have a greater than sign in an e-mail 
address. 

Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have a less than sign in an e-mail 
address. 

Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have a colon in an e-mail address. Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have a semicolon in an e-mail 
address. 

Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have a double quote in an e-mail 
address. 

Inaccurate email address information. 

E --INVALID_EMAIL:You cannot have two consecutive periods in an e-
mail address. 

Inaccurate email address information. 

E --INVALID_EMAIL:An @ sign cannot be directly followed by a period 
in an e-mail address. 

Inaccurate email address information. 

E --INVALID_EMAIL:An @ sign cannot be directly preceded by a 
period in an e-mail address. 

Inaccurate email address information. 

E --INVALID_EMAIL:The extension '.edy' is not a valid extension in an 
e-mail address. You probably mean '.edu' 

Inaccurate email address information. 

E --INVALID_EMAIL:The extension '.con' is not a valid extension in an 
e-mail address. You probably mean '.com' 

Inaccurate email address information. 

E --MISSING_SSL The transaction must be performed 
using SSL (Secure Sockets Layer) 

E --IP_NOT_ALLOWED The IP address for this transaction is 
not allowed. 

E --BAD_PASSWD The password supplied is inaccurate. 

E --AUTH_FORCE_DISALLOWED This account cannot use the 
AUTH/FORCE or 
OFFLINEAUTH/OFFLINEFORCE 
combinations 
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10.5 CERTEGY ECC Responses from the Gateway: 

 
Code MESSAGE 

Y CHECK IS ACCEPTED FOR CONVERSION 
Y CONVERSION OF CHECK REVERSED 
N  CHECK HAS ALREADY BEEN VOIDED 
N COMM ERROR BBAL 
N GENERAL TRANSACTION ERROR 
N CHECK IS NOT ACCEPTED FOR CONVERSION 
N INVALID MERCHANT 
N SUCCESSFULL BANK BALANCE REPORT 
N NO STATION RECORD EXISTS 
N DUPLICATE EFT 
N INVALID REFERENCE NUMBER 
N TOO LATE TO VOID CHECK 
N REFERENCE NUMBER/AMOUNT MISMATCH 
N CALL AUTHORIZATION CENTER 
N NO CONNECTION BS 
E Improper Merchant ID! Value: 
E Unknown Service Type: 
E Lane Number not between 0 and 99: 
E Department Number not between 0 and 99999999: 
E Receipt Header too long! (Max = 256 chars) 
E Receipt Footer too long! (Max = 256 chars) 
E Boolean value expected! (T, t, Y, Yes, y, yes, 1 or F, f, N, No, n, no, 0) 
E Invalid Service Type! (Should be FM1 or FM2!) 
E Improper Merchant ID! Value:& Value) 
E Merchant with that ID does not exist! 
E Improper MICR Line! (Should be 15-36 chars!) 
E Check amount invalid! (must be 0 to $99,999.99) 
E Third Party Reference Number incorrect format (should be 4-9 Alpha chars)! 
E ID Date of Birth incorrect format (should be 4-8 chars)! 
E Invalid phone number! (Should be 10 digits no hyphens!) 
E Invalid State Code: 
E Invalid driver's license state code! 
E Invalid ID number! (Should be 5-2048 characters.) 
E Invalid driver's magnetic track 1 data! 
E Invalid driver's magnetic track 2 data! 
E Invalid driver's magnetic track 3 data! 
E Invalid SSN! (Should be 9 chars no hyphens!) 
E Invalid Passport number (4-24 chars)! 
E Invalid Military ID (4-24 chars)! 
E Barcoded ID incorrectly formed Base64 format! 
E Lane Number Max = 99! 
E Clerk ID Max = 9999! 
E Unknown Product Type:& Value) 
E Unknown Transaction Type:& Value) 
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E Incorrect Report Date Format:& Value) 
E Incorrect Terminal_Type Format:& Value) 
E Unknown XML name:+ tmpStr) 
E Incorrectly formed XML Transaction! (No child nodes) 
E Missing ID! (Must have DL# SSN Passport Military or barcoded ID!) 
E Unknown Service Type! (Must be FM1 or FM2!) 
E Incorrect Merchant ID length! 
E Missing Terminal Type! 
E AUTH not allowed! (Merchant setting allows "Conversion Only) 
E Check Amount not set! 
E Manually entered check number missing! 
E MICR Source not set or incorrect! 
E MICR Line missing for "SALE" or "AUTH"! 
E Reference number must be set for "VOID"! 
E Return Amount must be set for "VOID"! 
E Date for Bank Balance Report not set! 
E Transaction Type not set or incorrect! 
E Server URL missing! 
E Incorrect TCP/IP Port number! 
E Incorrect host TimeOut setting! 
E No response received from processor! 
E Received NAK response to request! 
E Unrecognized response! 
E No response received! 
E Bad request format: 
E MerchantID missing or incorrect for ACK Message! 
E Reference no. missing or incorrect for ACK Message! 
E Could not connect to the website! 
E ~The connection to the website failed! 
E ~Unable to send the transaction request! 
E ~Failed to receive ENQ! 
E ~Connection shut down while waiting on ENQ! 
E ~Unable to receive the ENQ! 
E ~Unable to send the transaction request! 
E Unable to receive the reply! 
E ~Unable to send the ACK! 
E ~Host connection closed prematurely before receiving response 
E Unable to receive the reply! 
E ~Unable to send the ACK message! 
E ~Unable to setup to receive the EOT reply! 
E ~Unable to receive the EOT reply! 
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10.6 SLIM CD Decline Codes from the Gateway: 

 
 Decline codes from the processor will be in the following format: 
 
DECLINE XX YZ  
 
Where the XX is a processor-specific numeric decline code. The Y represents an 
AVS character, and the Z represents the CVV2 reply.  
 
 

Code EMessage portion Explanation 
N *APPROVELIMIT_REACHED_FOR_THIS_CARD Internal fraud screening due to frequent use 

of card. 
N -AVS_CODE_BANNED The Address Verification Results (AVS) are 

not acceptable to the merchant’s bank.  
Use the billing address of the cardholder. 
-OR-  
A merchant’s customer used a non-us card 
and the merchant’s bank will only allow the 
acceptance of US-issued cards. 

N INVALID_GIDENTIFIER-xxx xxx will represent the invalid processor 
identifer.  This is a configuration issue, and 
must be fixed by the Slim  CD support staff. 

N DECLINE_51 Declined due to internal fraud screening 
N DECLINE_56 Declined due to internal fraud screening 
N DECLINE_57 Declined due to internal fraud screening 
N DECLINE_58 Internal fraud screening due to frequent use 

of card. 
N *ERROR:Country/state do not match area-code/phone 

number:1 
Fraud screening 

N *ERROR:Zipcode does not match country/state 
verification failed:2 

Fraud screening  

N *ERROR:Zipcode does not match country/state:3 Fraud screening 
N *This phone number cannot be accepted Fraud screening – a mobile phone or pager 

has been identified in a transaction. 
N  53_Do_not_honor Card is not acceptable. 
N CARD_BANNED Card is not acceptable. 
N IP_BANNED IP is not acceptable. 
N CCODE_BANNED Country is not acceptable. 
N BAD_CCODE County code not accurate 
N BAD_IPCC IP not allowed 
N BAD_BINCC Card Not allowed 
N NEGATIVEDB_BLOCK Transaction declined 
N NEGATIVEIP_BLOCK Transaction declined 
N CCODE_BLOCK Transaction declined 
N IPCARDLIMIT Transaction declined 
N DECLINELIMIT Transaction declined 
N APPROVELIMIT Transaction declined 
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10.7 SLIM CD AVS /CVV2 Codes from the Gateway: 

 
The following table presents AVS character replies and their meanings: 
 
AVS Letter Meaning 

A Address matches - Zip Code does not 
B Street address match, Postal code in wrong format. (international issuer) 
C Street address and postal code in wrong formats 
D Street address and postal code match (international issuer) 
E AVS Error 
G Service not supported by non-US issuer 
I Address information not verified by international issuer. 
M Street Address and Postal code match (international issuer) 
N No match on address or Zip Code 
O No Response sent 
P Postal codes match, Street address not verified due to incompatible 

formats. 
R Retry - system is unavailable or timed out 
S Service not supported by issuer 
U Address information is unavailable 
W 9-digit Zip Code matches - address does not 
X Exact match to address and 9-digit Zip Code 
Y Address and 5-digit Zip Code match 
Z 5-digit zip matches - address does not 

Space No response sent from issuer or processor 
 
The following table presents CVV2 replies and their meanings: 
 
CVV2 Letter Meaning 

M CVV Matched. 
N CVV No Match. 
P Not Processed. 
S CVV is on the card, but the shopper has indicated that CVV is not 

present. 
U Issuer is not VISA certified for CVV and has not provided Visa encryption 

keys or both. 

 
WARNING: PLEASE NOTE THAT A TRANSACTION CAN BE APPROVED 
EVEN IF THE AVS OR CVV2 REPLY DO NOT MATCH!  IT IS UP TO THE 
MERCHANT TO VOID TRANSACTIONS THAT RESULT IN AVS OR CVV2 
REPLIES THEY DO NOT WISH TO ACCEPT THE TRANSACTION. 
 
 
 


